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Exceed onDemand Administrator’s 
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Contains information for administrators about installing 
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Hummingbird Exposé Online

Hummingbird Exposé Online is an electronic mailing list and online newsletter. It was created to facilitate the delivery 

of Hummingbird product-related information. It also provides tips, help, and interaction with Hummingbird users. To 
subscribe/unsubscribe browse to the following web address:
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The user group is an unmoderated, electronic mailing list that facilitates discussion of product-related issues to help 
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To join a user group:
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exceedusers@hummingbird.com
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Chapter 1: Introducing Exceed onDemand
About Exceed onDemand

Exceed onDemand is a server-based PC X server designed and optimized to 
run on intranet, internet, and extranet network connections. It delivers 
X11R6.6 X access with minimal overhead, and requires only a small 
client-side installation that enables users to access business-critical 
X applications on UNIX, Linux, VMS, and other X Window System hosts.

Features and Functionality
A number of key features ensure secure, consistent, and dependable 
X connections for end users, a scalable and expandable architecture, and a 
centralized management environment for administrators.

Authentication and Encryption
Exceed onDemand authenticates user names and passwords for all host 
connections, but you can configure additional security options. Some are 
available only with the Strong Encryption version of Exceed onDemand.

Secure Sockets Layer (SSL)     Ensures secure communication between 
Exceed onDemand Server and Exceed onDemand Client or Server Manager.

Secure Shell Startup Mode     Extends security by encrypting user 
credentials and X11 traffic that pass between Exceed onDemand Server and 
the host on which X applications are located.

RSA Authentication     Extends security by authenticating users based on 
RSA SecurID patented technology.
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Session Suspend and Resume
Users can suspend their X sessions instead of closing them and terminating 
all X applications. When they reconnect to the host, Exceed onDemand 
gives them the option of resuming the suspended session. Users can set an 
additional option that allows the X application to continue functioning 
while the X session is suspended. If enabled by the administrator, users can 
resume suspended sessions remotely from different client PCs.

Auto-Suspend upon Disconnection
In the event of an X session connection failure, Exceed onDemand Server 
maintains the session. When the user reconnects, he or she may resume the 
session without having to reload applications.

X Session Sharing
Exceed onDemand lets users share their X session to one or more users. 
Users with whom sessions are shared may either view or participate in the 
session from their computers depending on the permissions granted to each 
user by the session owner. This feature is useful when providing a 
demonstration, working remotely, or getting technical support.

Load Balancing
Administrators can install more than one Exceed onDemand Server on a 
network to form a cluster. Each node in the cluster is linked to and 
controlled by one node that is designated the cluster manager node. Exceed 
onDemand Clients attempting to initiate a session connect to the cluster 
manager node, which distributes the new sessions to the nodes that have the 
least load.
4
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Global X Configuration Files
Administrators can create any number of global Xconfig files (.cfg) to 
provide users with standardized session configurations. After you create a 
global Xconfig file, it is available for use by any user with an active account. 
These users cannot edit this new file unless you distribute it to them directly 
or they make a copy of it. The Server Manager lets you manage user and 
global Xconfig files.

Global Xstart Files
Xstart lets you automate the process of connecting to a host and starting 
X applications that reside on it. With Xstart, users can create, configure and 
manage their Xstart files (.xs). As with Xconfig files, administrators can use 
Server Manager to create any number of global Xstart files to provide users 
with standardized X application startup.

Server Management
With Exceed onDemand Server Manager, administrators can configure 
Server and user settings, manage licenses, and view information about 
Exceed onDemand Client sessions currently running or suspended on any 
local or remote Exceed onDemand Server.

Exceed onDemand Components

Exceed onDemand Client     Exceed onDemand Client is the client portion 
of the software responsible for displaying X applications and allowing users 
to interact with them. Administrators distribute Client to each end user. 
You can also use the Exceed onDemand Deployment Wizard to create 
Client deployment packages to deploy Client to any PC using a web 
browser.

Exceed onDemand Server     Exceed onDemand Server is the processing 
hub of Exceed onDemand. It is the link between X applications and Exceed 
onDemand Client. By default, Exceed onDemand Server is configured to 
operate as a stand-alone server, but administrators can set up clusters. For 
more information, see “Exceed onDemand Server Architecture” on page 9.
5
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Exceed onDemand Server Manager     Exceed onDemand Server Manager 
is a management tool for Exceed onDemand administrators. You can install 
it on any network PC, and use it to remotely manage any Exceed onDemand 
Server (UNIX or Windows) installed on the network.

Exceed onDemand Deployment Wizard     This component is comprised 
of three wizards:

• Project Deployment Wizard—Lets you create Exceed onDemand Client 
deployment packages. You can use the packages to make Exceed 
onDemand Client installation available to in-house and remote end 
users over the Web.

• Index Page Wizard—Lets you generate an HTML web page that 
contains links to multiple deployment projects created with Project 
Deployment Wizard.

• Projects Update Wizard—Lets you update Exceed onDemand Client 
files within selected deployment projects without having to manually 
apply changes to each individual project.

Exceed onDemand Print Utility     With Exceed onDemand Client, users 
can access remote files and print them as they would local files. Exceed 
onDemand Print Utility facilitates this functionality and is provided on the 
Exceed onDemand CD. In order to enable printing, system administrators 
must copy or install it on each machine running X applications from which 
users need to print.

Exceed onDemand Keyboard Editor     This tool simplifies the job of 
creating and modifying keyboard definition files.
6



Chapter 1: Introducing Exceed onDemand
Types of Connectivity

Exceed onDemand enables two types of connectivity: direct client-server 
connectivity and gateway server connectivity.

Direct Client-Server Connectivity
Exceed onDemand Client users access X applications that reside directly on 
an Exceed onDemand Server machine, be it stand-alone or part of a cluster.   

Exceed onDemand Clients

Thin X protocol traffic

Exceed onDemand Server
on UNIX/Linux/NT 

applications
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Gateway Server Connectivity
Exceed onDemand Server is not required to be installed on every machine 
on which X applications reside. Instead, Exceed onDemand Server, whether 
stand-alone or part of a cluster, can act as a gateway between Exceed 
onDemand Clients and X applications running on other machines.

Exceed onDemand Server

Exceed onDemand Clients

VMS HostLinux HostUNIX Host

Thin X protocol traffic

X protocol traffic

on UNIX/Linux/NT 

applications applicationsapplications
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Exceed onDemand Server Architecture

By default, Exceed onDemand Server is configured to operate as a stand-
alone server, but administrators can link together multiple installations of 
Server to form a cluster. Regardless, of how Exceed onDemand Server is 
configured, however, the underlying architecture of the Server components 
is the same. That is, stand-alone installations of Exceed onDemand Server 
operate as local, one-node clusters.

Exceed onDemand Server is comprised of three main components:

Exceed onDemand Cluster Manager     The Cluster Manager component 
runs on stand-alone installations of Exceed onDemand Server or on the 
cluster manager node in a cluster environment. Cluster Manager is 
responsible for authentication, licensing, user and server configuration, 
load balancing, and X session initialization and configuration.

Exceed onDemand Proxy Manager     The Proxy Manager component runs 
on all installations of Exceed onDemand Server, whether stand-alone or 
part of a cluster. Proxy Manager receives Exceed onDemand Client requests 
to start X sessions and proceeds to start a proxy with a unique display ID for 
each X session request. In some cases, it may reuse an existing proxy to 
handle the new X clients.

Exceed onDemand Proxy     Exceed onDemand Proxy is an X server that is 
launched on demand by Proxy Manager to handle all the X protocol 
requests for an X session. One installation of Exceed onDemand Server can 
run multiple proxies at once, each uniquely identified by a display number. 
The proxy does not handle drawing requests or keyboard and mouse input 
natively. Instead, it translates them to equivalent Thin X Protocol 
commands before transmitting the requests to Exceed onDemand Client.
9
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Overview of Cluster Architecture

You can link together multiple installations of Exceed onDemand Server to 
form a cluster. You must designate one instance of Server to be the cluster 
manager node, and then configure all other installations of Exceed 
onDemand Server, referred to as nodes, within the cluster.

One of the benefits of implementing a Server cluster is that it offers 
automatic load balancing, whereby Exceed onDemand Clients attempting 
to initiate X sessions connect to the cluster manager node, which is always 
aware of the CPU loads of all nodes in the cluster. Cluster Manager 
distributes the new sessions to the nodes that have the lowest CPU load in 
order to maximize stability and performance.

About the Cluster Manager Node
What distinguishes the cluster manager node from other Exceed onDemand 
Server nodes in the cluster is that it is the point of entry for all Exceed 
onDemand users and administrators.

Whether you want to start an X session with Exceed onDemand Client or an 
Exceed onDemand Server management session with Server Manager, you 
always connect to the cluster manager node, more specifically, to the Exceed 
onDemand Cluster Manager component. The cluster manager node also 
houses all Xconfig (.cfg) and Xstart (.xs) files, both global and those that 
belong to users.

Note: Stand-alone installations of Exceed onDemand Server 
operate as local, one-node clusters. Therefore, Exceed 
onDemand Cluster Manager runs on each non-cluster installation 
of Server.
10
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About Nodes
A node is any instance of Exceed onDemand Server that belongs to a cluster 
but is not configured to be the cluster manager node. Users of Exceed 
onDemand Client or Server Manager never connect directly to a node. 
Instead, they connect to the cluster manager node.

The primary components running on any node are Exceed onDemand 
Proxy Manager and the proxies it establishes to run X sessions and to which 
it assigns a unique display ID. When users connect to the cluster manager 
node (Cluster Manager), it assigns the startup request to the node (Proxy 
Manager) in the cluster with the most available resources based on CPU 
usage. Proxy Manager then starts a proxy or reuses an existing one for the 
session.

How a Cluster Works

1.  Connect to Exceed onDemand Cluster Manager
When Exceed onDemand Client attempts to initiate an X session, it 
connects to Cluster Manager, which runs on the cluster manager node. 
Cluster Manager receives the request, authenticates the user, and checks the 
license information.

Exceed onDemand 
Proxy Manager

Cluster Manager

 Exceed onDemand Server

Exceed onDemand 
Client

Configuration Connection

Cluster Manager NodeClient PC
11



Exceed onDemand Administrator’s Guide
2.  Redirect to Exceed onDemand Proxy Manager
Cluster Manager then redirects Exceed onDemand Client to connect to the 
Exceed onDemand Proxy Manager running on the node with the most 
available resources (based on CPU usage). If the cluster manager node itself 
has the most available resources, its own Proxy Manager receives the Client 
connection. Cluster Manager also sends to Proxy Manager the Xconfig 
settings specified by the user.

Exceed onDemand 
Proxy Manager

Cluster Manager

 Exceed onDemand Server

Exceed onDemand 
Client

Configuration Connection

Nodes

 Exceed onDemand Server

Exceed onDemand 
Proxy Manager

X Session Connection

(Thin X Protocol)

Client PC Cluster Manager Node
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3. Start Proxy
Proxy Manager then starts a local proxy to run the X session, assigns it a 
unique display ID and sends startup information to the client. The 
X application connects to the proxy. All X session communication between 
Exceed onDemand Client and the X application is mediated by the proxy. 
X applications communicate with the proxy using the X protocol, and the 
proxy communicates with Exceed onDemand Client using the Thin X 
Protocol (TXP). 

Exceed onDemand 
Proxy Manager

Cluster Manager

 Exceed onDemand Server

Exceed onDemand 
Client

Configuration Connection

Nodes

 Exceed onDemand Server

Exceed onDemand 
Proxy Manager

Proxy 1 Proxy 2 Proxy 3

applications

X Session Connection

(X Protocol)

Host Machine

X Session Connection

(Thin X Protocol)

Client PC Cluster Manager Node
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About Node Synchronization
In a cluster environment, node synchronization is an important 
administrative consideration. It ensures that X sessions launch successfully 
and work in a consistent manner regardless of the node that receives the 
connection request. 

System clocks     You must synchronize the system clocks on all nodes. If a 
node’s system clock is not synchronized with the clock on the cluster 
manager node, X session startup may fail.

Font databases     The font database must be identical on all cluster nodes 
to avoid unwanted font substitutions. For more information, see 
“Managing Fonts” on page 80.

SSL keys and certificates     All cluster nodes must have the same SSL keys 
and certificates to optimize SSL security. X sessions started on nodes 
without the required keys use anonymous SSL authentication. For more 
information on SSL keys and certificates, see “About Exceed onDemand 
SSL Features” on page 76.

Directory Services     If you use Secure Shell startup method, all nodes in a 
cluster should share the same user database (NIS, NIS+, or LDAP) to ensure 
successful X application startup with Xstart.
14
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Chapter 2: Installing Exceed onDemand
Overview of Installation

Installing Exceed onDemand is a three-part procedure:

For more information on 
supported platforms, see 
“System Requirements” on 
page 19.

1 Install Exceed onDemand on a UNIX, Linux, or Windows platform. If 
you install Exceed onDemand on Windows, you can select and install 
other Exceed onDemand components.

2 Install the following Exceed onDemand components as required on 
other network machines:

• Exceed onDemand Server Manager

• Exceed onDemand Tools, including Print Utility (elpr) and XKeys

For more information, see “About Exceed onDemand Components” on 
page 29.

3 Make Exceed onDemand Client available to users.

Migrating Files When Upgrading
Exceed onDemand 5 is not backward compatible with version 4.x. When 
you install Exceed onDemand 5 on a machine where an earlier version was 
installed, both the Hummingbird Setup Wizard and the UNIX installer 
migrates some directories and files to avoid the need to reconfigure the 
product and to maintain existing profiles.

Exceed onDemand Server
When you upgrade from version 4.x to 5, the Exceed onDemand 
installation (Windows and UNIX) migrates the following:

• new-user (default) account settings

• global and user-specific configuration profiles

• user-specific account settings

• SSL keys

• any manually added fonts (not originally installed with version 4.x)
17
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Exceed onDemand Server Manager
Hummingbird Setup preserves your SOCKS configuration. The file is saved 
in the version 5 default location.

Exceed onDemand Client
Exceed onDemand Client version 5 is not backwards compatible with 
version 4.x. When you install the new version, Hummingbird Setup 
migrates any connection documents (.eod files) saved in the default 
location, and then uninstalls version 4.x. The SOCKS configuration file is 
also preserved.

If you upgrade from Exceed onDemand Client version 3.2 to 5, 
Hummingbird Setup does not uninstall the older version. Instead, it copies 
the connection documents and SOCKS configuration file saved with 
version 3.2 to the version 5 default location, and both versions of the client 
co-exist on your machine.

Registering
You can register this product by:

• running Msetup.exe from the product CD, then clicking Register Online

• completing and registering the form at the following URL:

http://www.hummingbird.com/register/

• completing the registration card provided in the product package and 
mailing it to Hummingbird Ltd.

After registering, you and your organization are recognized as a licensed 
product owner with all rights and privileges. This makes you eligible to 
receive a wide range of customer services, such as a free subscription to our 
quarterly newsletter, Hummingbird Exposé Online, as well as notification of 
software upgrades and new products. If you and your organization move to 
a new location, complete and mail the change of address card included in 
the product package. This ensures you will continue receiving update 
notices and other important information.
18
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System Requirements

Exceed onDemand Server 
A host with 256 MB RAM and 140 MB of disk space is recommended. 
Exceed onDemand Server supports the following platforms:

• Sun SPARC Solaris 2.6, 7, 8, 9, 10

• Sun Intel Solaris 8, 9, 10

• HP-UX 11.x

• IBM AIX 5.x

• Linux kernel level 2.4 or greater

• Windows 2000

• Windows Server 2003

• Windows XP Professional

Exceed onDemand Components
A Pentium or higher with 64 MB RAM is recommended. Exceed 
onDemand Client, Server Manager, and Deployment Wizard support the 
following Windows platforms:

• Windows 98/Me

• Windows 2000

• Windows Server 2003

• Windows XP Professional
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Installing Exceed onDemand Server on a UNIX Platform

You must have root or superuser access on the machine on which you want 
to install Exceed onDemand Server. Make sure you have sufficient disk 
space.

To install Exceed onDemand Server:

1 Log in as root user:

$su root

passwd: Password

2 Go to the Exceed_onDemand/Server directory on the CD. From the 
folder that coincides with your operating system, copy the self-
extracting executable to a local directory. These files are named 
according to platform and operating system.

3 Run the executable from its new location.

4 Specify a location to which the installer should extract the files, or 
accept the default location.

5 Once all necessary files are extracted, the license agreement appears. 
Read the agreement and type y to accept the terms.

Note: Exceed onDemand Print Utility (elpr) is part of the Exceed 
onDemand Server for UNIX installation. However, you may have to 
install it independently on other machines. For more information, 
see “Installing Exceed onDemand Print Utility” on page 30.

Note: Failure to read the license agreement does not affect the 
terms and conditions of the agreement.
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6 When prompted, provide the following information:

• Cluster Manager Por t—Specify the port number on which the 
Cluster Manager listens. Press Enter to select the default port: 5500.

• Proxy Manager Port—Specify the number of the port through which 
the proxy transfers X session data. This port number must be 
different from the server port number. The default is 5501. Unlike 
the Cluster Manager port, changing this port from the default has 
no effect on users.

• Star ting Display ID—Specify the display number for the first Exceed 
onDemand Client session. All subsequent displays are numbered 
accordingly. Press Enter to select the default first display: 1.

7 On the confirmation screen, type y to confirm the settings.

8 If you installed version 4.x prior to this installation, indicate whether 
you want to copy settings from that installation.

9 The Activation Key utility opens. Select one of the five options by 
typing the number and pressing Enter. When you have performed all 
the required tasks, select option 4 to save the changes and exit the 
utility.

Note: 

• If you change the default port number, you must provide your 
users with the new number to enable them to connect to the 
server. 

• Exceed onDemand installs as a stand-alone server. Use 
Exceed onDemand Server Manager to add this server to a 
cluster if necessary.

Note: You do not necessarily need to specify an activation key at 
this time. You can later use Server Manager to enter the key.
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10 If version 4.x was not installed prior to this installation, you must enter 
the Exceed onDemand administrator account name. The administrator 
you designate can then add other accounts to the administrative group. 
Press Enter to select the default option.

The installer generates an installation log file and displays its location. 
You can refer to this file to ensure that the installation was successful.

11 When prompted to start Exceed onDemand Server, type y. The Server is 
now installed and started.

Uninstalling Exceed onDemand Server on UNIX

To uninstall Exceed onDemand Server:

1 Stop the server by running the eodstop utility.

2 Delete the Exceed onDemand Server installation directory from the 
UNIX host.

Installing Exceed onDemand on Windows

Before installing Exceed onDemand, you must log on with Administrator 
authority, and ensure that you have write access to the Windows system 
directory and registry. This is not the case for other components.

You can modify the installation and install any component independently 
on other network machines where necessary. For more information, see 
“About Exceed onDemand Components” on page 29.

Note: Users running the installation as Superuser accounts are 
not added to the Exceed onDemand administrative group 
automatically.
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To install Exceed onDemand on a Windows platform:

1 When you insert the CD into the drive, autorun launches the 
Hummingbird Master Setup application. If Master Setup does not 
launch automatically, run Msetup.exe from the root directory of the 
CD.

2 In the Hummingbird Master Setup application window, click Install 
Exceed onDemand.

3 In the next window, select the installation type. Hold the mouse pointer 
over an installation type to view a brief description of it.

Exceed onDemand Setup prepares Setup Wizard, checks the operating 
system, and checks the current Windows Installer version.

• If necessary, the version is updated and the Setup Wizard continues.

• If Windows Installer is not present on your operating system, or if 
the existing version is not 2.0, Setup Wizard installs the latest 
version of the service.

4 After configuring Windows Installer and preparing to install, Setup 
Wizard proceeds to the Welcome dialog box. Click Next.  

The Next button is 
unavailable if the terms of 
the license agreement are 
not accepted.

5 Read the license agreement. If you accept the terms, click Next.   

6 The Customer Information dialog box opens. Type the required 
information and indicate who may access this installation of Exceed 
onDemand. Click Next.

Note: To quit installation, click Cancel in any Setup Wizard dialog 
box. Your computer is not affected if you do this before the Setup 
Wizard copies files. To review or change settings in a previous 
dialog, click Back.

Note: Failure to read the license agreement does not affect the 
terms and conditions of the agreement.
23



Exceed onDemand Administrator’s Guide
7 The Custom Setup dialog box opens. Select the features you want to 
install and click Next. You can view information about features and 
perform the following customization:

• Expand a feature category by clicking the plus icon  to view a tree 
of features or sub-features. Similarly, click the minus icon  to 
collapse the feature tree.

• Click a feature icon to display a pop-up menu of icons and install 
options. Click a pop-up menu icon. The icon in the feature tree 
changes according to your selection. Click Help to view a dialog box 
with tips.

• Click Change to open the Change Current Destination Folder dialog 
box and install the feature to a folder other than the default. 

• Click Space to open a dialog box listing all local drives (logical 
partitions) and mapped drives on the machine. The dialog box 
provides detailed information about available disk space.

8 In the Server Settings dialog box, specify the following:

• Cluster Manager Port—This is the port number on which the Cluster 
Manager listens. Press Enter to select the default port: 5500.

Note: If you did not select the Exceed onDemand Server feature 
(component), proceed to step 10.

Note: For Windows XP (Service Pack 2), configure the firewall 
such that Cluster Manager and Proxy Manager ports are 
accessible, as well as a series of ports beginning with 6nnn where 
nnn represents port numbers starting with the initial display ID (for 
example, if the starting display ID is 100, then make accessible 
ports 6100, 6101, 6102, and so on).

Note: If you change the default port number (5500), you must 
provide your users with the new number to enable them to 
connect to the server. 
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• Proxy Manager Port—Specify the number of the port through which 
the proxy transfers X session data. This port number must be 
different from the server port number. The default is 5501. Unlike 
the server port, changing this port from the default has no effect on 
users.

• Star ting Display ID—Specify the display number for the first Exceed 
onDemand Client session. All subsequent displays are numbered 
accordingly.

• Activation Key—Type the activation key (located on the product CD 
package). You are allotted 10 attempts to enter the correct 
activation key before Setup closes. 

If you leave this box blank, you receive a limited license. You can use 
Server Manager to install a valid activation key.

• Administrator Account—Displays the machine name and the 
Administrator account name. If you want to specify another 
account that has administrator privileges, type that account name.

Click Next.

9 The Ready to Install the Product dialog box opens. Select whether or not 
to launch the Exceed onDemand Client installer after the current 
installation. Click Install to continue.

10 When the installation is complete, click Finish. You may be prompted to 
restart your computer.

Note: For information on uninstalling Exceed onDemand for 
Windows, see “Program Maintenance” on page 26.
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Program Maintenance
Program maintenance lets you modify, repair, or uninstall existing 
Hummingbird products and components installed on a Windows platform. 
You can access Program Maintenance from either the product CD or by 
clicking Add/Remove Programs in Control Panel.

To modify the install state of program features and components:

1 Open Program Maintenance by running Msetup.exe from the product 
CD. Alternatively, double-click Add/Remove Programs in Control Panel, 
select the Hummingbird program in the Add/Remove Programs dialog 
box, and click Change. The Setup Wizard Welcome dialog box opens.

2 Click Next. The Program Maintenance dialog box opens.

3 In the Program Maintenance dialog box, select Modify and click Next. The 
Custom Setup dialog box opens.

4 Expand the feature tree and change the install state, as necessary, and 
then click Next. 

• Expand a feature category by clicking the plus icon  to view a tree 
of features or sub-features. Similarly, click the minus icon  to 
collapse the feature tree.

• Click a feature icon to display a pop-up menu of icons and install 
options. Click a pop-up menu icon. The icon in the feature tree 
changes according to your selection. Click Help to view a dialog box 
with tips.

5 In the next dialog box, click Install and the install state of program 
features changes according to your specifications.

6 Installation (modification) proceeds to completion. Click Finish to exit.
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To repair a program:

1 Open Program Maintenance by running Msetup.exe from the product 
CD. Alternatively, double-click Add/Remove Programs in Control Panel, 
select the Hummingbird program in the Add/Remove Programs dialog 
box, and click Change. The Setup Wizard Welcome dialog box opens.

2 Click Next. The Program Maintenance dialog box opens.

3 In the Program Maintenance dialog box, select Repair and click Next.

4 The Ready to Repair the Program dialog box indicates Setup Wizard is 
ready. Click Install to repair errors such as missing or corrupt files, 
shortcuts, and registry entries.

5 Program repair proceeds to completion. Click Finish to exit.

To remove a program:

1 Open Program Maintenance by running Msetup.exe from the product 
CD. Alternatively, double-click Add/Remove Programs in Control Panel, 
select the Hummingbird program in the Add/Remove Programs dialog 
box, and click Change. The Setup Wizard Welcome dialog box opens.

2 Click Next. The Program Maintenance dialog box opens.

3 Select Remove and click Next.

4 The Remove the Program dialog box indicates Setup Wizard is ready. 
Click Remove to uninstall the program.

5 Program removal proceeds to completion. Click Finish to exit.
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Silent Installation
A silent installation runs in the background. You can perform silent 
installations for Exceed onDemand (server-side) and Exceed onDemand 
Client. 

To run a silent installation:

1 Launch Setup Wizard from the command line using the syntax for the 
specific Exceed onDemand component you want to install:

• Server-side:

E:\Exceed_onDemand\Server\Win32\Setup.exe /S /V”/qn 
EOD_SERIALNUM=activationkey”

• Client:

E:\Exceed_onDemand\Client\EoD-5-Client.exe /S 

where E:\ is the CD-ROM drive. The following describes the silent 
installation options: 

2 Installation proceeds to completion.

Note: To install Exceed onDemand, you must log into the PC as 
the (local) administrator. This is not necessary to install Exceed 
onDemand Client.

Option Description

/S Specifies a silent installation.

/V/qn /V passes parameters to Msiexec.exe.

Note: There are no spaces between the /V and 
/qn options and that V is upper-case. If a character 
string contains a space, put quotes around it. For 
example: /V”parameter space”

EOD_SERIALNUM Specifies the activation key, located on the product 
CD package.
28



Chapter 2: Installing Exceed onDemand
Updating the Product
Hummingbird Update lets you check for Exceed onDemand updates issued 
by Hummingbird Ltd. The connection settings for Hummingbird Update 
are preconfigured. If necessary, you can edit the connection settings from 
the Settings page after you open the WebUpdate dialog box as described in 
the following procedure.

To update the product:

1 From the Windows Start menu, run Hummingbird Update. It is located 
in Administrative Tools in the Hummingbird Exceed onDemand 5 program 
group. The WebUpdate dialog box opens.

2 Select Hummingbird Exceed onDemand 5 and then click Check For 
Updates. If an update is available, you are prompted to install it. Click 
Yes.

The update downloads and Setup Wizard prepares the setup process.

3 You are informed when Setup Wizard is ready. Click Next.

4 Installation proceeds to completion.

About Exceed onDemand Components

After you install Exceed onDemand (on UNIX or Windows), you have the 
option of installing the components elsewhere on the network as required 
to suit your needs. 

You can install the following components independently:

Exceed onDemand Server Manager     Server Manager lets you remotely 
manage any Exceed onDemand Server (UNIX or Windows) on the 
network. You can install this tool on any network PC running a supported 
Windows platform.
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Exceed onDemand Deployment Wizard     This wizard lets you generate, 
distribute, and maintain web-deployable installations of Exceed onDemand 
Client, so that users can install the client from the Web.

Exceed onDemand Tools     

• Exceed onDemand Print Utility (elpr)—This utility lets users print 
from the X applications they run with Exceed onDemand. You must 
install the printing utility on each machine running X applications 
from which users need to print. The utility is installed with Exceed 
onDemand. However, in cases where users will use Exceed onDemand 
to connect to and print from X applications that are running on other 
machines, you must install the print utility on each of these machines as 
well. This component is available for UNIX and Windows.

• Exceed onDemand XKeys—XKeys is a keyboard editor that simplifies 
the job of creating customized keyboard definition files. To distribute 
the custom files you create, you can add them to global or user-specific 
configuration profiles. Install this tool on any PC running a supported 
Windows platform.

Installing the Components on Windows
To install an Exceed onDemand component on a supported Windows 
platform, follow the procedure for installing Exceed onDemand for 
Windows. When Hummingbird Setup Wizard presents the Custom Setup 
dialog box, select only the component(s) you want to install.

For an alternative method of installing Exceed onDemand Print Utility, or 
to install the utility on a UNIX platform, see below.

Installing Exceed onDemand Print Utility
Exceed onDemand Print Utility (elpr) is installed automatically with Exceed 
onDemand Server for UNIX, and is an optional installation when you 
install Exceed onDemand for Windows.

Note: A readme for the print utility is located in the 
\Exceed_onDemand\Utilities\elpr directory on the CD.
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A stand-alone version is also available on the product CD. You must install 
the stand-alone version on any machine (other than the Exceed onDemand 
server machine) that runs X applications from which your users need to 
print. 

To copy Exceed onDemand Print Utility from the CD:

1 In the /Exceed_onDemand/Utilities/elpr directory, open the folder 
that coincides with the operating system of the machine on which you 
want to install the Print Utility. 

2 Copy the elpr file to a local directory. Ensure that the directory is 
accessible to Exceed onDemand Client users.

Uninstalling Components

If you installed components using Hummingbird Setup Wizard:

To remove all, select Hummingbird Exceed onDemand in the Windows 
Add/Remove Programs dialog box, and then click Remove. If you do not 
want to remove all components installed on the machine, click Change 
instead of Remove and select the components you want to remove. For 
more information on changing or removing an installation, see “Program 
Maintenance” on page 26.

If you copied Exceed onDemand Print Utility from the CD:

Delete the elpr file from the installation location.

Note: For an alternative method for installing Exceed onDemand 
Print Utility on Windows, see “Installing the Components on 
Windows” on page 30.
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Installing Exceed onDemand Client

The Exceed onDemand system administrator makes the Client installation 
available to users. Because the installation is small, you may opt to 
distribute the file over the network, or by e-mail or browser download. An 
end user can install Client as long as that user has write permission for the 
destination folder.

To install Exceed onDemand Client:

1 Insert the product CD into your CD ROM. 

2 In the Master Setup window, click Install Exceed onDemand Client, and 
then click Install Exceed onDemand Client.

3 In the Welcome window, click Next.

4 Read the license agreement. Click Yes to accept the terms.

5 In the Destination Folder dialog box, confirm the folder destination. To 
install in a different directory, click Change and select another directory. 
To create a desktop shortcut, click the check box. Click Next.

6 In the Language Selection dialog box, select the languages you want to 
the product to support. To select the default language, double-click that 
language. Click Next.

Note: 

• You can use Exceed onDemand Deployment Wizard to create 
an installation package to deploy Exceed onDemand Client 
over the web. For more information, install the Deployment 
Tools and refer to the Help.

• You can also perform a silent installation. For more information, 
see “Silent Installation” on page 28.

Note: Failure to read the license agreement does not affect the 
terms and conditions of the agreement.
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7 The Ready to Install dialog box opens. Click Install to begin the 
installation.

8 After Setup completes all operations, click Finish. When the installation 
is finished, an Exceed onDemand Client shortcut appears in the 
Hummingbird Exceed onDemand 5 program group on the Start menu 
(and on the desktop if that option was previously selected).

Uninstalling Exceed onDemand Client
To uninstall Exceed onDemand Client, you must remove the following two 
application using the Add/Remove Programs feature in Windows Control 
Panel:

• Hummingbird Exceed onDemand Client

• Hummingbird Component Deployment

After uninstalling the Hummingbird Component Deployment, you must 
reboot the PC.
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About Exceed onDemand Deployment Wizard

Exceed onDemand Deployment Wizard simplifies the task of Exceed 
onDemand administration. With this wizard, you can do any of the 
following:

• Distribute Exceed onDemand Client to both local and remote end users 
over the Web.

• Preconfigure Exceed onDemand Client sessions that are launched from 
a web page to ensure optimal performance. For example, you can 
automate the connection to the host so that when users launch a session 
from the web page, they are logged into a specific host using the 
connection parameters that you specify.

• Create an HTML index, which contains links to multiple Client sessions 
on a single web page.

• Update your users’ Exceed onDemand Client software automatically by 
deploying the latest version from the web server.

The Exceed onDemand Deployment Wizard consists of the following 
components:

Project Deployment Wizard        You can use the Project Deployment 
Wizard to create a web-deployable installation of Exceed onDemand Client 
for end users. When you build a deployment project and place it on a web 
server, the end user can access Exceed onDemand from the specified URL.

Index Page Wizard     The Index Page Wizard lets you create a single web 
page that contains links to multiple deployment projects previously created 
in the Project Deployment Wizard. You can then move the index page (with 
all of the projects to which the index page points) to a web server and 
distribute the URL to users.

Projects Update Wizard      The Projects Update Wizard simplifies the task 
of updating the Exceed onDemand Client version within existing 
deployment projects. You can use this wizard to select deployment projects 
that you want to upgrade from one product version to another, so that the 
contents of the generated directory structure contain the new or changed 
files. If you install an update patch of Exceed onDemand on your machine, 
and then recreate one or more deployment projects, the updated 
Exceed onDemand components are included.
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Getting Started

To launch Exceed onDemand Deployment Wizard:

From the Start menu, navigate to the Hummingbird Exceed onDemand 
program group, and then click Exceed onDemand Deployment Wizard.

To create a deployment project, on the Welcome page of the Exceed 
onDemand Deployment Wizard, select Project Deployment Wizard from the 
Wizard Type drop-down list. 

When you have created several projects, you can use the Index Page Wizard 
to create an HTML index that contains links to multiple projects on a single 
web page. You can also use the Projects Update Wizard to select deployment 
projects that you want to upgrade from one version to another.

For example, you could use Project Deployment Wizard to create different 
deployment projects of Exceed onDemand Client for each department in 
your company, and then use the Index Page Wizard to create an index page 
that contains links to all of the projects you created. You could then 
distribute one index page URL to all departments. Users from each 
department could open a deployed Client project on their machine by 
selecting the appropriate link on the index page. 

Deploying Exceed onDemand Client consists of three basic steps:

1 Use Exceed onDemand Deployment Wizard to generate an HTML page 
and a deployment package. 

2 Move the generated files to the web server.

3 Distribute the URL of the project location (on the web server) to end 
users. 

When a user clicks the URL link, the content of the project is extracted and 
deployed to the user’s machine and is used to launch an Exceed onDemand 
Client session. 
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About Deployment Projects
If you choose (on the Deployment Project Information page) to create and save 
a deployment project, Project Deployment Wizard takes the information 
you provide and generates a completed deployment project.

A deployment project contains the following elements:

A ProjectName Directory     This directory is saved to the location you 
specified in the Project Destination Directory box and contains the following:

• A Package folder, which contains Package Assembly (.dpf) files. These 
files describe all Exceed onDemand components, regardless of the 
settings in the deployment project, and are deployed to the end user’s PC.

• An Images folder, which contains the Exceed onDemand Client banner, 
as well as any image files that you specify to be included in the project. 

You can create multiple 
web pages in each project.

• A generated web page (.html file) that combines all of these components. 
When the end user clicks the link on this web page, the files that are 
needed to start an Exceed onDemand session are deployed to their PC.

A Deployment Project (.edp) file     This file is saved in the EoD Projects 
folder and describes the deployment project.

To create a deployment project, use Project Deployment Wizard to create a 
web page, and then transfer the output files to a web server and distribute 
the URL to specific users.

End users access the web page and click the link to access a deployed 
Exceed onDemand session. If any component installations or updates are 
necessary, they happen at this time. 

The first time the end user clicks a particular project link, the Deployment 
Runtime component deploys the necessary components to the user’s 
machine. If the end user has previously clicked a project link, the 
Deployment Runtime component determines if any component updates are 
necessary and makes those changes before launching the session.

About HTML Indexes
For more information, see 
“Using the Index Page 
Wizard” on page 48.

If you choose to create an index page, the Index Page Wizard lets you specify 
multiple existing deployment projects and then generates a single web page 
(an .html file) that contains multiple links, one for each project. You can 
then distribute this single URL to end users.
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Using the Deployment Wizard

Exceed onDemand Deployment Wizard lets you create or edit deployment 
projects, which users can use to access Exceed onDemand Client from a 
specified URL on a web server.

To launch the Deployment Wizard:

From the Start menu, navigate to the Hummingbird Exceed onDemand 
program group, and then click Exceed onDemand Deployment Wizard.

Step 1: Selecting a Wizard Type
The Welcome To The Exceed onDemand Deployment Wizard screen lets you 
select from the following wizard types:

• Project Deployment Wizard—To build a deployment project.

• Index Page Wizard—To build an index web page for selected 
deployment projects.

• Projects Update Wizard—To update selected deployment projects.

Note: For detailed information about the three wizard types, see 
“About Exceed onDemand Deployment Wizard” on page 37.
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To create a deployment project:

1 If necessary, select Project Deployment Wizard in the Wizard Type box.

2 Click Next to specify project information.

Step 2: Specifying Deployment Project Information
The Deployment Project Information screen lets you work with an existing 
deployment project or create a new project. 

To create a new project:

1 If necessary, clear the Use An Existing Deployment Project box.

2 In the When Finished, Save Project list, select a save method.

3 In the Project Name box, type a new name for the project, or accept the 
suggested name.

4 Click Next to specify connection information.
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To make changes to an existing project:

1 Select Use An Existing Deployment Project, and then select a project in the 
tree. 

2 In the When Finished, Save Project list, select a save method. 

3 If you do not want to overwrite the original project, type a new name in 
the Project Name box.

4 Click Next to specify connection information.

Step 3: Specifying Connection Settings
The settings in the Launch Parameters area let you specify the parameters for 
launching Exceed onDemand Client. If you provide all the information that 
is required to establish a connection, Client automatically launches based 
on the parameters you specify. If you do not provide some or all of the 
connection parameters, Client prompts the user for missing information 
before connecting.
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To specify connection settings:

Right-click a Connection 
Document name to cut, 
copy, delete or rename it.

1 Select a connection document to provide connection information. The 
launch parameters specified in the connection document are 
automatically displayed in the Launch Parameters area.

For more information, see 
Exceed onDemand Client 
Help.

If there are no connection documents listed, you can create one using 
Exceed onDemand Client. Click the Refresh button to update the 
directory tree after creating a new connection document.

2 To clear the connection document selection, click Reset. Click Load to 
browse for a connection document.

3 Click Next to select language options.

Step 4: Selecting Language Options
The Supported Languages area shows a list of available languages that you 
can include in the deployment project. This area lets you specify or change 
the language(s) as well as set the default language.
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To select deployment languages:

1 In the Supported Languages area, select one or more languages to be 
made available to the user.

2 In the Default Language box, select one language to be the default.

To specify client settings:

1 Select Logging to let users generate a log file that records the actions they 
perform.

2 Select Star tup Monitor to enable the progress monitor, which lets the 
users view information about the Client connection to the server 
during startup. 

3 Click Next to provide web server information.

Step 5: Providing Web Server Information
These settings let you specify project output settings, web page information, 
and web server settings.
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To specify project output settings:

1 In the HTML File Name box, type a name for the HTML file that Project 
Deployment Wizard generates to contain the project link.

For more information, see 
“Deploying a Project” on 
page 53.

2 In the Project Destination Directory box, specify a directory in which you 
want to place all of the wizard-generated content. Click the browse 
button to search for a location.

To specify web page settings:

1 In the HTML Page Title box, specify the name you want to appear in the 
title bar of the browser when end users access the web page. This name 
is also used as an identifying string on any index page that includes this 
project.

2 If you want to display a background image while installation files are 
deploying to the end user’s machine, specify a location for an image file 
(or browse to one) in the Background Image File Name box.

To specify web server settings:

Project Deployment Wizard lets you specify a directory on the web server 
that points to your web images.

1 If you specify a background image in the Web Page Settings area, you 
can specify the directory on the web server that points to your web 
images in the Image Vir tual Directory box.

By default, the HTML code looks for image files in the Images folder. If 
you specify a virtual directory in the Image Vir tual Directory box, the 
HTML code is modified to point to that location. Therefore, you do not 
have to manually edit each HTML file to update the image location. 

2 To avoid being disconnected as a result of a network timeout, select 
Enable HTTP Timeout and specify a timeout value that is less than the 
network idle timeout.

3 Click Next to specify installation settings.

Note: If you specify a virtual directory, you must transfer your 
images from the Images folder in the project destination directory 
to the specified folder on the web server.
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Step 6: Specifying Installation Settings
The Installation Settings screen lets you specify how Exceed onDemand 
Client is deployed to the end user’s machine. 

To change the installation settings:

1 In the Program Files Installation Type list, select one of the following 
options:

• All Users—Deploys Exceed onDemand Client to the target 
computer for anyone who uses it, and applies the installation 
settings to everyone using that machine. 

• Per-User—Applies installation settings to the user logged onto the 
target machine at the time of deployment. Access to the Exceed 
onDemand Client session is restricted to this user. 
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2 In the Installation Path Type list, select one of the following options to 
specify a location for the Client deployment on the end users’ machines. 

• Use Default Installation Path—Exceed onDemand Client is 
deployed to the end user’s machine in the default location.

• Prompt User for Installation Path—End users are prompted to 
browse to an installation directory. 

• Use Specified Installation Path—Enables the Path box, in which you 
can specify a directory where Exceed onDemand Client is deployed 
on the end user’s machine.

 

3 In the Settings Path Type list, select one of the following options:

• Use Default Settings Path—Installs Exceed onDemand user files in 
the default location on the end user’s machine.

For a list of replacers that 
you can use to specify an 
installation path or a 
shortcut location, see the 
Directory Variables table in 
Deployment Wizard Help.

• Use Specified Settings Path—Enables the Path box, in which you 
can specify a directory where Exceed onDemand user files are 
installed on the end user’s machine.

4 Select Create Shortcut if you want a shortcut to Exceed onDemand 
Client to appear on each end user’s desktop. You can specify an 
alternate location for the shortcut.

5 Click Build to build your deployment project. When the project is 
completed, click Finish to save the deployment project and close the 
Deployment Wizard. 

6 Copy the wizard-generated files from your output folder to a web server 
directory. Make sure to include the HTML file and the contents of the 
Package and the Images folders.

Note: After the end user deploys Exceed onDemand Client, you 
cannot change the installation path. For example, if two projects 
are deployed—each containing a different installation path—the 
installation path specified in the first project is applied to both.
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Using the Index Page Wizard

To create index pages, launch Deployment Wizard from the Star t menu. 
Select Index Page Wizard in the Wizard Type box on the Welcome screen.

The Index Page Wizard process consists of the following steps:

• selecting a deployment project

• specifying HTML page information

Step 1: Selecting a Deployment Project
The Deployment Project Selection screen lets you choose the deployment 
project(s) that you want included in the HTML index.

On this screen, the wizard lists all deployment projects previously created 
and saved in the EoD Projects directory.

To select projects to include on the index page:

1 Select the check box beside each project you want to include in the 
index. To include all the projects in the list, select Deployment Projects.

2 Click Next to specify information for the HTML page of the index.
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Step 2: Specifying HTML Page Information
The HTML Page Information screen lets you specify settings for the index page 
output and the web page. You can also specify web server and display settings.

For more information, see 
“Step 5: Providing Web 
Server Information” on 
page 44.

When you are finished creating an index, the wizard places an HTML file in 
the output directory you specify. You can then move the index file to a web 
server directory.

To configure index page output settings:

1 In the Index Page File Name box, specify a name for the wizard-generated 
HTML file.

For more information, see 
“Issuing the URL for an 
Index Page” on page 54.

2 In the Index Page Destination Directory box, specify a directory in which 
you want to place the HTML file. Click the browse button to search for 
a location.

The relative locations of the output directory for the index page and for the 
associated deployment project(s) must be preserved on the web server for 
the index page links to remain valid.
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To configure web page settings:

1 In the Index Page Title box, specify a title to appear in the title bar of the 
browser window containing the index page. 

2 In the Background Image File Name box, you can specify an image file to 
appear in the background of the index page. Click the browse button to 
search for an image file.

To configure web server and display settings:

The Index Page Wizard lets you specify a directory on the web server that 
points to your web images.

1 If you specify an image file in the Web Page Settings area, you can 
specify the directory on the web server that points to your web images 
in the Image Vir tual Directory box. 

By default, the HTML code looks for image files in the Images folder. If 
you specify a virtual directory in the Image Vir tual Directory box, the 
HTML code is modified to point to that location. Therefore, you do not 
have to manually edit each HTML file to update the image location. 

2 In the Index Page box, you can choose whether you want the deployed 
Exceed onDemand Client to open in the same browser window as the 
index page. If you want to keep the index page and the deployed project 
open at the same time, select Open in New Browser. 

3 Click Build to create the index page.

Copy the following files to the virtual directory on the web server:

• The HTML file for the index.

• The HTML file for the project.

• All of the files in the Package folder and the Images folder.

Note: If you specify a virtual directory, you must transfer your 
images from the Images folder in the project destination directory 
to the specified folder on the web server.
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The relative locations of the output directory for the index page and for the 
associated deployment project(s) must be preserved on the web server for 
the index page links to remain valid.

Based on your specifications, the wizard generates an HTML web page and 
places a link on this page to each deployment project you specified during 
the process. The generated HTML file is located in the output folder that 
you specified in the Project Destination Directory box.

Using the Projects Update Wizard

For information about 
accessing the Projects 
Update Wizard, see “About 
Exceed onDemand 
Deployment Wizard” on 
page 37.

The Exceed onDemand Projects Update Wizard simplifies the task of 
updating the Exceed onDemand Client version within existing deployment 
projects.

For example, you can use Projects Update Wizard to upgrade from one 
version of selected deployment projects to another without having to 
manually apply changes to each individual project. 

To launch the Projects Update Wizard:

To update deployment projects, launch Exceed onDemand Deployment 
Wizard from the Start menu. Select Projects Update Wizard in the Wizard Type 
box on the Welcome screen.
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Updating Deployment Projects
The Deployment Project Selection screen lets you choose the deployment 
project(s) that you want to upgrade.

On this screen, the Projects Update Wizard lists all previously created 
deployment projects.

To update deployment projects:

1 Select the check box beside each project that you want to update. Select 
Deployment Projects to update all of the projects in the list.

2 Click Build to update the specified deployment project(s). Deployment 
Packager generates and saves the updated output files. 

3 Click Finish to close the wizard.

4 Copy the updated contents of the project destination directory, 
including the Package and the Images subfolders, to the virtual 
directory on the web server.
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Deploying a Project

The deployment project 
and index output files are 
located on your local 
machine in the specified 
destination directories.

When you have copied the generated files from the output folder to the web 
server, distribute the URL of the web server virtual directory to end users. 

Issuing the URL for Deployment Projects
You can place the project files in any web server directory. Internally, HTML 
files and deployment components use relative URLs to locate other objects, 
enabling you to move the deployed files to another web server without 
having to edit the file location path.

Copy the output files (preserving directory structure) to the HTML Virtual 
Directory Path. The project URL that you distribute to end users is as follows:

http://ServerAddress/HTMLVirtualDirectoryPath/HTMLFileName.html

where:

• ServerAddress is the server address (domain name or IP address) of 
your web server.

• HTMLVirtualDirectoryPath is the name of the directory path that you 
created for the HTML files.

• HTMLFileName is the file name of the generated HTML file that contains 
the download link to the project. Enter this name in the HTML File Name 
box on the Web Server Information screen.

If you create a deployment project named YearEnd for the Finance 
department, and you place the project in the PROJ\Finance directory on a 
server named WebServer, you would distribute the following URL to the 
end-users in the Finance department:

http://WebServer/PROJ/Finance/YearEnd.html

After copying the output files to the web server, distribute the project URL 
to end users.

Note: Make sure that the output directory for the index page and 
for the associated deployment project(s) are the same. The 
relative locations of these files must be preserved on the web 
server for the index page links to remain valid.
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Issuing the URL for an Index Page
Copy the index page output files (preserving the directory structure) to the 
HTML Virtual Directory Path. The index page HTML file and all projects 
included on the index page must be in the same directory on the web server 
for the links to remain valid. 

The index page URL that you distribute to end users is as follows:

http://ServerAddress/HTMLVirtualDirectoryPath/IndexPageFileName.html

where:

• ServerAddress is the server address (domain name or IP address) of 
your web server.

• HTMLVirtualDirectoryPath is the name of the directory path that you 
created for the index page.

• IndexPageFileName is the file name of the generated HTML file that 
contains links to the projects. Enter this name in the HTML File Name 
box on the HTML Page Information screen.

If you create an index page called Finance.html that contains links to all of 
the deployed projects for the Finance department, and you locate this index 
page in the PROJ\Finance directory on the server called WebServer, you 
would distribute the following URL to end users in the Finance department:

http://WebServer/PROJ/Finance/Finance.html

When you have finished copying the output files to the web server, you can 
distribute the URL for the index to end users.
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About Exceed onDemand Administration

The task of managing Exceed onDemand includes:

• configuring Exceed onDemand Server by specifying port numbers, or 
enabling/disabling security features

• cluster administration (if applicable)

• configuring user account settings that permit or restrict Exceed 
onDemand users access to specific functionality

• tracking session information such as which users are currently running 
client sessions, or how many sessions are currently suspended

• creating and distributing Xconfig files to users

• creating and distributing Xstart files to users

• managing licenses

• troubleshooting 

In this chapter, you will find information on performing Exceed onDemand 
Server management tasks for both Windows and UNIX installations of 
Exceed onDemand Server.

About Exceed onDemand Server Manager 

Exceed onDemand Server Manager is a management tool for Exceed 
onDemand administrators. You can install it on any network PC, and use it 
to remotely manage any Exceed onDemand Server (UNIX or Windows) 
installed on the network. You can configure server and user settings, manage 
licenses, and view information about and manage Exceed onDemand Client 
sessions currently running or suspended on a particular Exceed onDemand 
Server.
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You can also use Server Manager to configure user accounts, and to create 
and manage the distribution of Xstart files and Xconfig files. 

Connecting to the Server

After you install Exceed onDemand Server Manager, you can launch it from 
the Windows Start menu. When you do, the Exceed onDemand Server 
Manager window opens, which lets you connect to and manage any Exceed 
onDemand Server on the network.

If you experience problems logging into an Exceed onDemand Server 
installed on Windows XP or Windows Server 2003, see “Troubleshooting 
Connections to Exceed onDemand Server” on page 59.
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To connect to Exceed onDemand Server:

1 In the Server Manager window, click Connect on the File menu. The 
Connect dialog box opens.

2 Provide the following information:

• Host—Type, or select from the drop-down list, the name of the 
Exceed onDemand Server machine. If that server has been 
configured to use a server port number other than the default 
(5500), you must type a colon and the customized port number 
after the host name:

hostname:portnumber

• User ID—Type your user ID for the specified server. When 
connecting to Exceed onDemand Server installed on Windows, 
provide the domain name and your user name as follows:

domain\username

• Password—Type your password.

3 Click OK.

To end the Server Manager session, click Disconnect on the File menu.

Troubleshooting Connections to Exceed onDemand Server
If the Exceed onDemand Server you want to log into is installed on 
Windows XP or Windows Server 2003, you cannot start a client or 
administrative session if you are using a local account with no password. 
This is a result of a Windows XP/Server 2003 feature that limits the use of 
blank passwords on local accounts to console logon only.
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To remove this limitation:

1 In Control Panel, select Switch To Classic View, if necessary.

2 In Administrative Tools, open Local Security Policy.

3 Expand Local Policies and select Security Options.

4 Disable the following option—Accounts: Limit Local Account Use Of 
Blank Passwords To Console Logon Only.

Configuring Cluster Settings

To set up a cluster, you must configure the Cluster Manager settings for the 
cluster manager node. These settings include connection, security and 
logging settings.

To configure cluster settings:

1 With Exceed onDemand Server Manager, connect to the cluster 
manager node.

2 On the Cluster menu of the Exceed onDemand Server Manager window, 
click Settings. The Cluster Settings dialog box opens.
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3 Configure the necessary settings.

Cluster Manager Port—Specify the number of the port on which the 
Exceed onDemand Cluster Manager listens for startup requests from 
Exceed onDemand Client or Server Manager. You can specify a port 
number from 1 to 65655. The default value is 5500. 

Enable SSL—Enable this option if you want all Exceed onDemand 
Client connections (to Cluster Manager, Proxy Manager, and the proxy) 
to use SSL security.

Authentication Type

Native—Select this option if you want Exceed onDemand Server to 
authenticate users based on their user name and password.

PAM—The PAM (Pluggable Authentication Modules) option is 
available only for Exceed onDemand Servers installed on Solaris and 
Linux. Select this option if you want Server to pass users’ Exceed 
onDemand Client credentials to a PAM module for verification.

Note: If you change the default port number, you must notify your 
users. When connecting to the host, users will have to specify the 
new port number in the Host box as follows:

HostName:PortNumber

Warning!  

• Exceed onDemand Client is available in three versions. Only 
the Strong and Weak encryption versions are compatible with 
an SSL-enabled cluster. Users who install the version of Client 
with no encryption cannot connect to the cluster. 

• All cluster nodes must have the same SSL keys and 
certificates. For information on SSL keys, see the Exceed 
onDemand Administrator’s Guide.
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PAM Authentication Prompt—In most cases, PAM prompts users for 
their passwords before permitting the connections. You can prevent this 
prompt by typing the PAM authentication prompt in the box. For 
example, if PAM prompts users with the word “Password:”, then type 
Password: in the PAM Authentication Prompt box. If a prompt from PAM 
matches the one you specify, Exceed onDemand Server automatically 
responds with the user’s Exceed onDemand Client password.

Cluster Manager Password—Type a password. When you add a node 
to the cluster, it is this password that you will configure the node to use 
to gain access to Cluster Manager.

Enable Log—Enable this option if you want Exceed onDemand Cluster 
Manager to generate a log. If you enable the log, select either HTML or 
Text as the log file format.

4 Click OK to apply the settings.

Configuring Node Settings

This procedure guides you through the process of configuring node settings 
for Exceed onDemand Server. If there is more than one Server on the 
network, you should repeat this procedure for each. After you modify these 
settings, you must restart the Exceed onDemand Proxy Manager running 
on the newly configured node.

Note: The PAM service name for Exceed onDemand, which is 
used when configuring PAM settings on the server, is 
exceedondemand. Consult your vendor’s documentation for 
information on PAM configuration.
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To configure node settings:

1 In the Exceed onDemand Server Manager window, click Nodes in the 
tree pane. The information pane displays the names of one or more 
Exceed onDemand Server hosts.

2 In the information pane, select the node you want to configure by 
clicking its name in the Host Name column.

3 On the Node menu, click Settings. The Node Settings dialog box opens 
displaying the name of the selected node in the title bar.

4 Make the necessary setting changes. Click Help to view descriptions of 
each setting.

5 When you have completed the modifications, click OK.

6 Restart Proxy Manager. For more information, see “Restarting Proxy 
Manager” on page 73.
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Adding Nodes to a Cluster

After you add a new node, you must restart its Proxy Manager to make it 
available to the cluster. For this reason, it is recommended that no X session 
be running prior to adding the new node, as the sessions are terminated 
upon restarting the Proxy Manager.

You must also add the new node’s license activation key(s) to the cluster 
manager node. If you do not, the licenses from the newly added node will 
not be made available in the cluster.

To add a node to a cluster:

1 With Exceed onDemand Server Manager, connect to the Exceed 
onDemand Server machine you want to add to the cluster.

2 In the tree pane, click Nodes. The information pane displays the 
stand-alone Server machine status table.

3 In the information pane, click the host in the Host Name column.

Warning!  

• You must synchronize the system clocks on all nodes. Nodes 
that are not synchronized with the cluster manager node may 
not start sessions.

• Font database must be identical on all cluster nodes.

• All cluster nodes must have the same SSL keys and 
certificates.
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4 On the Node menu, click Settings. The Node Settings dialog box opens 
displaying in the title bar the name of the host you want to add to the 
cluster.

5 In the Cluster Connection area, select Cluster Node and provide the cluster 
connection information. Click Help to view descriptions of each setting.

6 Click OK.

7 On the Node menu, click Restart Proxy Manager.

The node is now part of the cluster. You can no longer connect directly to it. 
To manage this node or to start an Exceed onDemand Client session, 
connect to the cluster manager node.
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Removing Nodes from a Cluster

You can remove a node from a cluster by making it a stand-alone Exceed 
onDemand Server again. After you remove a new node, you must restart its 
Proxy Manager. For this reason, it is recommended that no X session be 
running prior to removing the node, as the sessions are terminated upon 
restarting the Proxy Manager.

To remove a node from a cluster:

1 In the Exceed onDemand Server Manager window, click Nodes in the 
tree pane. The information pane displays the name of one or more 
nodes.

2 In the information pane, select the node you want to remove by clicking 
its name in the Host Name column.

3 On the Node menu, click Settings. The Node Settings dialog box opens 
displaying the name of the selected node in the title bar.

4 In the Cluster Connection area, click Local Node, and then click OK.

5 With the node still selected in the Server Manager window, click Restar t 
Proxy Manager on the Node menu.
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Managing Licenses

Exceed onDemand offers two types of licenses:

Shared     One license is used per active X session. When a user ends or 
suspends his or her session, the occupied license is released and can then be 
re-used by any other user. When all licenses are in use, no other user can 
start an X session until a license becomes available.

Assigned     The number of active user accounts cannot exceed the number of 
licenses purchased. If, for example, five assigned licenses are installed, the first 
five users that are granted an active account are the only users who can start 
X sessions. These five users then share the five licenses as described above. If 
any other user needs access, then the administrator must deactivate one of the 
five user accounts and activate the new user’s account.

Licensing in a Cluster Environment
When adding a new Exceed onDemand Server node to a cluster, the licenses 
on the newly added node are not added to the cluster’s license pool. That is, 
Exceed onDemand does not transfer the new node’s licenses to the cluster 
manager node, which is responsible for licensing all users that connect to 
the cluster. Administrators must add the activation keys to the cluster 
manager node.

Managing Activation Keys
To add a new activation key, click Activation Keys on the Server Manager 
Cluster menu. In the Exceed onDemand Activation Keys dialog box, type or 
paste the key into the New Key box, and click Add.

To delete an activation key, select it in the key list, and click Delete.

Note: When you configure default settings for new user accounts, 
you can specify that accounts are not automatically activated for 
users who log in for the first time. Then you can activate accounts 
on a per-user basis. This may be useful in relation to license 
management.
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Managing User Accounts

The user account settings let you configure user accounts and control user 
access to certain functionality. To manage user accounts, you can configure 
settings on a default as well as a per-user basis.   

Default accounts are created for users the first time they log onto Exceed 
onDemand. All new users receive the default settings you specify in the New 
User Settings dialog box. 

You then have the option of customizing the settings on a per-user basis 
using the User Settings dialog box. For more information, see the following 
procedures.

To configure the default account settings for new users:

1 On the User menu of the Exceed onDemand Server Manager window, 
click New User Settings.

Note: Administrators cannot edit their own account settings.
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2 In the New User Settings dialog box, you can enable or disable the 
following settings:

• Server Administrator Account—This option is not available for 
new accounts.

• Account Active—Activates new user accounts. If you disable this 
option, accounts are created for new users, but they are not active. 
In this case, first-time users cannot start X sessions until you 
activate their accounts on a per-user basis. For more information, 
see the next procedure.

• Suspend Sessions—Lets new users suspend their X sessions. For 
more information on Suspend/Resume functionality, see Exceed 
onDemand Client Help.

• Resume Sessions From Anywhere—Lets new users resume 
suspended sessions from Exceed onDemand Client machines other 
than the ones on which the sessions were suspended. 

• Keep Suspended Sessions Active—Enable this option if you want 
X applications to remain active on the Exceed onDemand proxy 
after users suspend X sessions. This feature is useful when running 
X application processes, such as monitoring. Users can suspend and 
resume such sessions without interrupting the monitoring process.

• Suspend Disconnected Sessions—Automatically suspends users’ 
X sessions in the event of a network connection failure or Exceed 
onDemand Client PC crash. Users can then resume their sessions 
instead of having to start new sessions and launch X applications 
again. This feature is useful in unstable environments as it 
safeguards users’ work. It also saves time by avoiding lengthy 
X application restarts after a disconnection.

• Edit Xconfig—Lets new users create and edit user-specific Xconfig 
files.

• Share Sessions—Lets new users share their sessions with other users.

• Maximum Number of Sessions—Specifies the maximum number 
of sessions the new user may run at once. Specifying zero (0) lets 
the user run an unlimited number of sessions.

3 Click OK.
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To configure user-specific account settings:

1 In the Exceed onDemand Server Manager window, click Users in the 
tree pane. The information pane displays the names of one or more 
Exceed onDemand users.

2 Select the user whose account you want to configure.

3 On the User menu, click Settings. 

4 The User Settings dialog box opens. The name of the selected user 
appears in the title bar. You can enable or disable the following settings:

• Server Administrator Account—Automatically enables all 
permissions, giving the selected user administrative privileges. 
Administrators can create and edit global Xconfig files as well as 
user-specific Xconfig files. They can also configure user account 
settings.

• Account Active—Disable this option to deactivate an account and 
prevent the selected user from starting an X session and managing 
his or her Xconfig files.

• Suspend Sessions—Lets the user suspend X sessions. For more 
information on Suspend/Resume functionality, see Exceed 
onDemand Client Help.

• Resume Sessions From Anywhere—Lets the user resume suspended 
sessions from Exceed onDemand Client machines other than the 
one on which the session was suspended. 

• Keep Suspended Sessions Active—Enable this option if you want 
X applications to remain active on the Exceed onDemand proxy 
after the user suspends an X session. This feature is useful when 
X application processes, such as compiling, require a lot of time to 
complete. Users can suspend and resume such sessions without 
interrupting the compiling process.

• Suspend Disconnected Sessions—Automatically suspends the 
user’s X sessions in the event of a network connection failure or 
Exceed onDemand Client PC crash. The user can then resume the 
sessions instead of having to start new sessions and launch 
X applications again. This feature is useful in unstable 
environments as it safeguards users’ work. It also saves time by 
avoiding lengthy X application restarts after a disconnection.
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• Edit Xconfig—Lets the user create and edit user-specific Xconfig files.

• Share Sessions—Lets the user share sessions with other users.

• Maximum Number of Sessions—Specifies the maximum number 
of sessions the new user may run at once. Specifying zero (0) lets 
the user run an unlimited number of sessions.

5 Click OK.

Removing Users from the Server
When you remove users from Exceed onDemand Server, their folders and 
files stored on the server are also removed including their Xconfig and 
Xstart files.

To remove a user from the server:

1 In the tree pane, click Users. A list of users appears in the information 
pane.

2 Select the user you want to remove.

3 On the User menu, click Remove.

Terminating User X Sessions

Administrators can terminate any user’s X session. When you terminate a 
session that is not suspended, Exceed onDemand Client notifies the user 
that the connection has been lost.

Warning!  When you terminate a user session, any unsaved work 
is lost.
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To terminate an X session:

1 In the Exceed onDemand Server Manager window, click Sessions or 
select a node in the tree pane. The information pane displays a list of 
currently running or suspended X sessions.

2 In the information pane, select the X session you want to terminate.

3 On the Node menu, click Terminate Session.

Terminating Management Connections

Administrators can terminate management connections in addition to user 
X sessions. Management connections include Exceed onDemand Client 
configuration connections as well as Server Manager connections.

To terminate a management connection:

1 In the Exceed onDemand Server Manager window, click the root node 
in the tree pane. The information pane displays a list of connections 
currently hosted by Cluster Manager.

2 In the information pane, select the connection you want to terminate.

3 On the Cluster menu, click Terminate Connection.

Viewing the Cluster Manager Log

If you enabled the Cluster Manager log, you can view the log by clicking 
View Cluster Manager Log on the Cluster menu. The log is displayed in either 
HTML or text format depending on the format selected when configuring 
the log. For more information on enabling and configuring this log, see 
“Configuring Cluster Settings” on page 60.

Note: The information pane also lists the connection created for 
your Server Manager session. You cannot terminate this 
connection from the Cluster menu. You must disconnect.
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Viewing the Proxy Manager Log

Each installation of Exceed onDemand Server runs a proxy manager. If you 
enabled the Proxy Manager log, you can view the log by selecting the node 
and clicking View Proxy Manager Log on the Node menu. 

The log is displayed in either HTML or text format depending on the log 
configuration settings. For information on enabling and configuring the 
Proxy Manager log, see “Configuring Node Settings” on page 62.

Restarting Cluster Manager

You must restart Exceed onDemand Cluster Manager whenever you modify 
the cluster settings.

To restart Cluster Manager:

In the Exceed onDemand Server Manager window, click Restart Cluster 
Manager on the Cluster menu. Exceed onDemand prompts you to confirm if 
there are any X sessions or management connections running in the cluster.

Restarting Proxy Manager

Each installation of Exceed onDemand Server runs a proxy manager. When 
you restart Exceed onDemand Proxy Manager, Exceed onDemand Client 
sessions running on the node are disconnected. Users will have to restart 
their sessions.

Warning!  When restarted, Cluster Manager performs a restart of 
all Exceed onDemand Proxy Managers running in the cluster. This 
closes all running and suspended sessions on the node. Exceed 
onDemand Client and Server Manager users will have to restart 
their sessions.
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To restart Proxy Manager:

1 In the Exceed onDemand Server Manager window, click Nodes in the tree 
pane. The information pane displays the name of one or more nodes.

2 In the information pane, select the node you want to restart by clicking 
its name in the Host Name column.

3 On the Node menu, click Restart Proxy Manager. Exceed onDemand 
prompts you to confirm.

Exceed onDemand UNIX Server Commands 

While you can use Exceed onDemand Server Manager to manage UNIX 
Servers, you can also use server commands to view server and user 
information. You can also perform tasks such as starting and shutting down 
the server. The administrative tools are located in the [install path]/bin 
directory.

Tree pane Information pane
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Starting Exceed onDemand Server
You can start the server by running the eodstart utility. For more 
information, refer to the manual pages in the [install path]/help 
directory.

Managing Activation Keys
You can change the activation key without reinstalling Exceed onDemand 
Server. Use the keymanager utility to do the following:

• add activation keys

• remove keys

• list installed activation keys

Saved changes take effect immediately.

Stopping Exceed onDemand Server
You can stop the server by running the eodstop utility. For more 
information, refer to the manual pages in the [install path]/help 
directory.

Viewing Server Information
You can view information such as when the server was last started, the 
number of users currently logged into the server, and their session 
information.

To view this information, use the eodinfo utility. For more information, 
refer to the manual pages in the [install path]/help directory.

Note: All keys should be of the same type (shared or assigned).
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Troubleshooting

Viewing Server Logs
If you need to view the server log file, you can access it in the 
[install path]/log directory. If you chose to generate the log file in text 
format, the file name is eodpm.txt for the Proxy Manager log or eodcm.txt 
for the Cluster Manager log. If you chose to generate the log file in HTML 
format, the file name is eodpm.html or eodcm.html, depending on the log 
type.

About Exceed onDemand SSL Features

Exceed onDemand is available in three versions. Only the Strong and Weak 
encryption versions are compatible with an SSL-enabled Cluster Manager. 
Users who install the version of Exceed onDemand Client with no encryption 
cannot connect to the Cluster Manager node. Furthermore, in a cluster 
environment, all nodes must have the same SSL keys and certificates.

The Cluster Settings dialog box in Exceed onDemand Server Manager lets 
you enable SSL, When you restart Cluster Manager after enabling this 
security feature, Cluster Manager sends an enable-SSL instruction to Proxy 
Manager. In a cluster environment, the instruction is sent to each node in 
the cluster. SSL encryption is then enabled for all Exceed onDemand Client 
connections (to Cluster Manager, Proxy Manager, and to the proxy).
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When using ciphersuites that use the Digital Signature Standard (DSS), 
Client verifies the identity of the server before establishing an 
SSL-encrypted session. For verification, the server needs a private key file 
and a certificate file. The private key file must be named ewebpriv.pem, and 
the certificate file must be named ewebcert.pem. If you are using 
anonymous authentication, these two files are unnecessary.

Generating the Private Key and Certificate Files
To generate the private key and the certificate file, use the openssl utility. 

                         Windows Before running the openssl utility on Windows:

1 Open the Windows Command Prompt window.

2 Open the Accessories folder in the Exceed onDemand installation 
path.

3 Proceed with the procedure provided below to run the openssl utility. 

                         UNIX/Linux Before running the openssl utility on UNIX/Linux:

If you are running this utility on a Solaris, AIX, Linux, or HP machine, 
ensure that the HOME environment variable is defined, and then define the 
following environment variables before running the utility.

Note: Exceed onDemand negotiates a number of ciphersuites. To 
view a list of available ciphersuites, consult the Cluster Manager 
log or the proxy log if you configured it to log SSL information. For 
more information on viewing the Cluster Manager log, see 
“Viewing the Cluster Manager Log” on page 72.

Note: 

• All cluster nodes must have the same SSL keys and certificates.

• openssl creates a file called .rnd in the current user’s HOME 
directory on UNIX, or in the root of the C: drive on Windows 
platforms.
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On Solaris, AIX, or Linux, if you are using C shell, specify:

<CR> indicates that the 
given text must be entered 
as one line with a carriage 
return at the end.

setenv LD_LIBRARY_PATH [install path]/bin/
sys:$LD_LIBRARY_PATH <CR>

On HP, if you are using C shell, specify:

setenv SHLIB_PATH [install path]/bin/sys:$SHLIB_PATH <CR>

To run the openssl utility:

1 Type the following command using the appropriate slash character:

cd [install path]\bin

2 At the prompt, type one of the following commands to generate 
random data. The command saves the random data to the rand.dat 
file. You can delete or refresh the rand.dat file at any time. 

• On a supported Windows platform:

openssl md5 file1 file2 file3 >rand.dat

where file# are files on your system, preferably files that change 
and are unique, such as log files.

• On all other platforms:

openssl md5 temporary directory/* >rand.dat

where temporary directory is a directory that contains system log 
files or other temporary files. For example, you can use the /tmp 
directory on UNIX or the system temp directory on Windows.

Warning!  On HP systems, you must also define the HOME 
environment variable in order to successfully run the openssl 
utility. You can set it to any directory.
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3 Type the following command to create the dsaparams file. This file 
contains the information required for generating a private key.

openssl dsaparam -rand rand.dat -out dsaparams <number of 
bits>

4 Type the following command to generate the key file (key.pem). 

openssl gendsa -rand rand.dat -out ewebpriv.pem dsaparams

5 Type the following command to generate a Certificate Signing Request 
(CSR). You require a CSR file if you want your certificate signed by a 
certificate authority (CA).

openssl req -config openssl.cnf -new -key ewebpriv.pem -out 
csr.pem

Note: 

• The <number of bits> parameter indicates the number of 
bits to generate in the private key. For US/Canadian domestic 
installations, 2048 bits is common. For export (outside the US 
and Canada) installations, this number is limited to 512 bits or 
less. 

• This step may take some time to complete depending on the 
speed of your machine and the number of bits you have 
specified.

Note: This command prompts you for information, such as 
your city, state/province, department, and e-mail address. 
When prompted for the Common Name, type the fully qualified 
domain name of the host you are planning to use as your 
server, for example, eod.hcl.com. If you would like to change 
the default responses for this information, edit the 
[req_distinguished_name] section of the openssl.cnf file.
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6 If you want to have your certificate signed by a CA, contact your CA for 
instructions on how to send them your CSR file.

If you do not want a CA to sign your certificate:

a) Type the following command to generate a self-signed certificate.

<CR> indicates that the 
given text must be entered 
as one line with a carriage 
return at the end.

openssl req -new -x509 -key ewebpriv.pem -out ewebcert.pem 
-config openssl.cnf <CR>

b) Move the files as follows:

Move ewebpriv.pem to [install path]/conf/home/keys/
ewebpriv.pem

Move ewebcert.pem to [install path]/conf/home/keys/ 
ewebcert.pem

Managing Fonts

Exceed onDemand administrators can manage the availability of fonts for 
Client sessions. During an X session, Exceed onDemand Client searches the 
database of fonts and font servers that you make available.

For more information on 
the Font Editor, see Exceed 
onDemand Help.

Exceed onDemand Client users can use the Font Editor to view the list of 
available fonts and font servers. They can enable or disable a font folder or 
server and set the search priority. When Exceed onDemand Client searches 
the database for a font, it searches only user-enabled font folders or font 
servers. It searches them in the order in which they appear in the Font Editor.

Warning!  In a cluster environment, the font database must be 
identical on all cluster nodes.
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On the Exceed onDemand Server, fonts are stored in one or more folders 
located in the font directory:

install directory/conf/home/font/font folder

where:

• install directory is the path created during Exceed onDemand Server 
installation.

• font folder is the name of the folder that contains:

• One or more font files—These can be .bdf or .pcf files. 

• A fonts.dir file—This file lists all font files located in the font 
folder.

• A fonts.alias file—This file lets you alias font names.

Controlling Font Availability
There are a number of ways in which administrators can determine which 
fonts are available to users. You can:

• modify the contents of existing font folders

• add new font folders/servers

• delete font folders/servers

To modify the contents of an existing font folder:

1 Copy new fonts into the font folder, or delete existing fonts from the 
folder.

The fonts.dir file located in 
the User font folder 
updates automatically.

2 Update the fonts.dir file located within the modified font folder by 
adding or removing the relevant font information.

3 If you need to give the font another name (alias), modify the 
fonts.alias file as well.
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To add a new font folder:

1 Create a font folder directly in the font directory. This folder must 
contain the fonts.dir and fonts.alias files. Alternatively, you can 
create a copy of the user font folder and rename it.

2 Copy fonts into the font folder.

The fonts.dir file located in 
the User font folder 
updates automatically.

3 Update the fonts.dir file located within the modified folder by adding 
to it the required information for each font in the folder.

4 If you need to give the font(s) another name (alias), modify the 
fonts.alias file as well.

To remove a font folder, delete it from the font directory.

To add or remove a font server:

Xconfig files are the means by which you can make a font server available to 
your users.

When configuring an Xconfig file, the Font tab of the Exceed onDemand 
Xconfig dialog box lets you add font servers to the font database. You can 
either create or edit an Xconfig file so that it specifies the font server. Users 
can then select the file for their sessions and access the font server.

For more information on Xconfig files and adding font servers to the 
database, see Exceed onDemand Server Manager Help.

Note: When you add a font folder, it appears in the user’s Font 
Editor, but is disabled by default. To use the fonts in the newly 
added folder, users must enable it.
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Creating and Distributing Custom Keyboards

XKeys, the Exceed onDemand keyboard editor, lets you create customized 
keyboards. The keyboard files provided with Exceed onDemand contain 
keyboard layout and symbol mappings. You can create an entire custom 
keyboard manually, but usually it is better to start with one of the existing 
keyboard files, then customize it to suit your needs. 

After you create a keyboard file, you must place it in the Common folder of 
the global or user-specific Xconfig directory. The folder in which you place 
the keyboard file will determine which users have access to it.

Global keyboard files are located on the server, in the global Common 
folder:

C:\Programfiles\Hummingbird\Connectivity\version\
ExceedonDemand\Server\conf\admin\Xconfig\Common

User-specific keyboard files are located on the server, in user-defined 
Common folders. For example:

C:\Programfiles\Hummingbird\Connectivity\version\
ExceedonDemand\Server\conf\users\username\Xconfig\Common

To customize a keyboard file:

1 Navigate to the location of the keyboard files on the server as described 
above.

2 Use Save As to rename and save a copy of one of the original keyboard 
files (.kbf). You will use this copy to create a custom keyboard. This is a 
precaution in case you change a setting and it does not work, or you do 
not like the new settings. 

Note: This procedure assumes you have installed the editor. If you 
have not, please refer to the installation chapter for information on 
how to install this utility.
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Chapter 5: Configuring X Sessions
About Xconfig

Xconfig files contain settings that Exceed onDemand uses to configure the 
look and behavior of X sessions. When starting an X session with Exceed 
onDemand Client, you must specify the Xconfig file you want to use to 
govern the behavior of the session. Administrators can create any number of 
Xconfig files to accommodate different session requirements and distribute 
the Xconfig files to users.

Xconfig file settings are grouped into fourteen categories. Each category is 
displayed on a tabbed page in the Exceed onDemand Xconfig dialog box.
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 The following table lists and describes Xconfig setting categories:

Input
These settings let you configure your input devices—
keyboard and mouse.

Communication
These settings let you select a startup mode for your 
session. You can also use the options on this page to 
configure all of the startup modes.

Security    

These settings let you restrict X application access to your 
Exceed onDemand Desktop. Using the Host Access 
Control List, you can configure Exceed onDemand 
Desktop to accept X applications only from certain hosts. 
Using the Authorization File, you can configure Exceed 
onDemand Desktop to accept X applications only if started 
from certain host logins/accounts.

Protocol   
These settings let you configure certain X protocol-related 
settings and determine which X protocol extensions are 
enabled or disabled.

Screen

These settings let you define various screen-related 
options. Some of the options you can configure include:

• the server visual model

• exit settings

• the window mode (single or multiple window mode)

• the window manager for use in multiple window mode

Performance

These settings let you maximize performance by 
configuring connection speed and compression settings. 
You can also enable or disable backing store and save 
unders. If backing store is enabled, you can define under 
what circumstances it is used. 

X Selection    
This setting lets you specify the X selection used in Exceed 
onDemand and X application copy/paste operations. You 
can also automate copy/paste functions.

Font

These settings let you customize the font database and 
specify the default text and cursor fonts. For information on 
making fonts available to users, see “Managing Fonts” on 
page 80.

Troubleshooting
These settings let you enable the logging of certain 
troubleshooting information to the log file. You can also 
enable trace from initial startup.
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There are two types of Xconfig file:

Global—These Xconfig files are created, managed and distributed only by 
administrators. Exceed onDemand installs with two global Xconfig files. 
One is the default file configured for passive startup, the other for XDMCP 
Broadcast. These files are available to all users the first time they connect to 
a host. Administrators can create more Xconfig files and make them 
available to all users or to specific users as required. All global Xconfig files 
have a .cfg extension and reside on the Exceed onDemand Server machine 
(cluster manager node or stand-alone) in the following location:

[install path]\conf\admin\Xconfig

User-defined—These Xconfig files are created and/or managed by users. 
User-defined Xconfig files also include Xconfig files that administrators 
create and distribute to users. Only administrators can access, edit, and 
delete the Xconfig files of another user. All user Xconfig files have a .cfg 
extension and reside on the Exceed onDemand Server machine (cluster 
manager node if in a cluster environment) in the following location:

[install path]\conf\users\username\Xconfig

System 
Administration

These options enable/disable the availability of some 
product features.

Other 
These settings are for advanced users. The default settings 
are suitable for most situations. For detailed information, 
see Exceed onDemand Help.

Printing
These settings let you enable and disable the print feature. 
You can manage print behavior and specify job size limits.

OpenGL
These settings let you enable and disable GLX extensions 
and OpenGL features.

Video

These settings let you define various video-related options. 
Some of the options you can configure include:

• the root window size

• the screen size

• the color database

Note: Xconfig file names are case sensitive on UNIX servers.
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Accessing Xconfig Files

Administrators can use Exceed onDemand Server Manager to view, edit, 
create and delete both global and user-specific Xconfig files. They can also 
manage the distribution of Xconfig files to Exceed onDemand users.

To access Xconfig files:

Start Exceed onDemand Server Manager and connect to Exceed onDemand 
Server by clicking Connect on the File menu. Do one of the following in the 
tree pane on the left:

• To access global Xconfig files, expand the Global Folders group and click 
Xconfig.

• To access user-specific Xconfig files, expand the Users group, select the 
user, and then click Xconfig.

The Xconfig files (.cfg) are listed in the information pane on the right. You 
can do the following:

• create a new Xconfig file from a copy

• edit an existing Xconfig file

• rename an Xconfig file

• delete an Xconfig file

• manage the distribution of Xconfig files to users

Note: Two global Xconfig files are installed by default with Exceed 
onDemand Server. There must always be one global Xconfig file 
set as the default.
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Creating Xconfig Files
Create multiple global and user-specific Xconfig files to provide users with 
more than one standardized X session configuration. After you create the 
files, you can manage their distribution. For example, you can create two 
files with different security settings and distribute them to users as required.

To create an Xconfig file:

1 Start Exceed onDemand Server Manager and connect to Exceed 
onDemand Server. 

2 Use the tree pane to access the Xconfig file space in which you want to 
create a new Xconfig file. You can create either a global or a 
user-specific Xconfig file. 

3 In the information pane, select an Xconfig file to use as the basis for the 
new Xconfig file.

4 On the Edit menu, click Copy. The information pane displays a new 
Xconfig file prefixed with the words Copy_of. The settings in this 
Xconfig file are the same as the original.

Tree pane with user-specific 
Xconfig file space selected
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You can change the name 
of an Xconfig file at any 
time. However, the name 
must follow certain rules. 
For more information, see 
“Naming Xconfig Files” on 
page 93.

5 If necessary, you can type a new name. Otherwise, press Enter on your 
keyboard.

6 With the new Xconfig file still selected, click Modify on the Edit menu to 
customize the settings. The Exceed onDemand Xconfig dialog box opens.

7 Modify the settings on the tabbed pages as required and click OK when 
you have made all the necessary changes.

Modifying Xconfig Files
After you create an Xconfig file, you can edit the settings at any time. 
Administrators can also edit the settings in any user’s Xconfig files.

To modify an Xconfig file:

1 Start Exceed onDemand Server Manager and connect to Exceed 
onDemand Server. 

2 Use the tree pane to access the Xconfig file you want to edit. You can 
modify either a global or a user-specific Xconfig file. 

3 In the information pane, select the Xconfig file you want to modify.
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4 On the Edit menu, click Modify. The Exceed onDemand Xconfig dialog box 
opens displaying the name of the selected Xconfig file in the title bar.

5 Modify the settings on the tabbed pages as required and click OK when 
you have made all the necessary changes.

Naming Xconfig Files
When naming an Xconfig file, keep the following rules in mind:

• You can use the following characters: Aa-Zz, ‘_’, ‘-’ and ‘.’.

• You cannot use names that consist solely of dots (.).

• You cannot use a name if it already exists (that is, two global Xconfig 
files or two user-defined Xconfig files cannot share a name, but a global 
Xconfig file can have the same name as a user-defined Xconfig file).

• You cannot use letter case to differentiate Xconfig files on Exceed 
onDemand Servers for Windows. Only UNIX servers are case sensitive.

To change the name of an Xconfig file:

1 Start Exceed onDemand Server Manager and connect to Exceed 
onDemand Server.

2 Use the tree pane to access the Xconfig file you want to rename. You can 
rename either a global or a user-specific Xconfig file.

3 In the information pane, select the Xconfig file you want to rename.

4 On the Edit menu, click Rename.

5 Type the new name, and press Enter on your keyboard.

Note: The changes you make to Xconfig settings will not be 
implemented in Client sessions that are currently running. They 
will take effect in subsequent sessions.
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Deleting Xconfig Files
Administrators can delete an Xconfig file, global or user-specific, at any 
time.

To delete an Xconfig file:

1 Start Exceed onDemand Server Manager and connect to Exceed 
onDemand Server.

2 Use the tree pane to access the Xconfig file you want to delete. You can 
delete either a global or a user-specific Xconfig file.

3 In the information pane, select the Xconfig file you want to delete.

4 On the Edit menu, click Delete. In the confirmation dialog box that 
opens, click Yes.

Managing Xconfig File Availability

Exceed onDemand Server Manager lets you control user access to Xconfig 
files. When you create a global Xconfig file, it is available for use by any user 
with an active account. Global Xconfig files cannot be edited by a user. You 
can, however, copy or move a global Xconfig file to any user’s Xconfig file 
space, in which case, the user can make modifications.

You can also copy and move user-specific Xconfig files to make them 
available globally or to other selected users.

To distribute Xconfig files to users:

1 Start Exceed onDemand Server Manager and connect to Exceed 
onDemand Server.

2 Use the tree pane to access the global or user-specific Xconfig file you 
want to distribute.
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3 On the Edit menu, do one of the following:

• Click Copy To to open the Copy Files dialog box, which lets you place 
an editable copy of the selected Xconfig file in any existing Xconfig 
file space, global or user-specific. If you are copying a global 
Xconfig file, the original global Xconfig file is still available to other 
users.

• Click Move To to open the Move Files dialog box, which lets you 
move the selected Xconfig file to any existing Xconfig file space, 
global or user-specific. Doing so makes the Xconfig file available 
only to the recipient.

4 In the dialog box that opens, select the destination of the Xconfig file 
and click OK.

Specifying a Default Xconfig File
Exceed onDemand Client uses the default Xconfig file when an Xconfig file 
is required but not specified by the user, or when the user selects the default.

Administrators can indicate the Xconfig file to be used as the default file. 
Any Xconfig file located in the global Xconfig folder is a candidate. Xconfig 
files that reside in user-specific Xconfig folders cannot be designated as the 
default.

To specify the default Xconfig file:

1 Start Exceed onDemand Server Manager and connect to Exceed 
onDemand Server.

2 In the tree pane, expand the Global Folders group and click Xconfig. A list 
of global Xconfig files appears in the information pane on the right.

3 Select the file that you want to designate as the default.

4 On the Edit menu, click Set As Default Xconfig.

Note: You cannot move, rename or delete the default Xconfig file.
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Chapter 6: Connecting with Xstart
About Xstart

Xstart lets you automate the process of connecting to a host and starting 
X applications that reside on it. With Xstart, you can create, configure, and 
manage Xstart files (.xs). In these files, you specify the host to which you 
want to connect, your login credentials, and the command line parameters 
necessary to start the X application you require. Your Xstart files are stored 
in your user directory in the Exceed onDemand Server installation path. 
Whenever you initiate an X session, you can access, run, or edit the Xstart 
files you have created or configure a new one.

There are two types of Xstart file:

Global—These Xstart files are created, managed, and distributed 
exclusively by administrators. These files are available to all users. All global 
Xstart files reside on the server in:

[install path]\conf\admin\Xstart

User-defined—These Xstart files are created and/or managed by users. 
(User-defined Xstart files also include those files that administrators create 
and distribute directly to specific users to manage.) Only administrators can 
access, edit, and delete the Xstart file of another user. All user-specific Xstart 
files reside on the server in:

[install path]\conf\users\username\Xstart

Supported Startup Methods
When you use Xstart to start an X session, you must specify the startup 
method you want to use to send your login credentials and commands to 
the remote host. Your selection is saved in the Xstart file (.xs) along with 
your credentials and any commands you provide. Xstart supports the 
following startup methods:

• REXEC 

• RSH

• RLOGIN

• TELNET

• Secure Shell
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Exceed onDemand Macros
When creating commands for REXEC, RSH, RLOGIN, TELNET, or Secure 
Shell, you can use Exceed onDemand macros to insert display and login 
information.

Accessing Xstart Files

Administrators can use Exceed onDemand Server Manager to view, edit, 
create, and delete both global and user-specific Xstart files. You can also 
manage the distribution of these files to Exceed onDemand users.

To access Xstart files:

Start Exceed onDemand Server Manager and connect to Exceed onDemand 
Server by clicking Connect on the File menu. Do one of the following in the 
tree pane on the left:

• To access global Xstart files, expand the Global Folders group and click 
Xstart.

• To access user-specific Xstart files, expand the Users group, select the 
user, and then click Xstart.

The Xstart files (.xs) are listed in the information pane on the right. You 
can do the following:

• create a new Xstart file

• modify an existing Xstart file

• rename an Xstart file

• delete an Xstart file

• manage the distribution of Xstart files to users
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Creating Xstart Files

To automate host access and X application startup, you can save the 
connection information and commands you specify in the Exceed 
onDemand Xstar t dialog box. The information is saved to an Xstart file (.xs). 
The Xstart files you create are stored in your user directory in the Exceed 
onDemand Server installation path. Whenever you initiate an X session 
with Exceed onDemand Client, you can access the Xstart files you have 
created and run the appropriately configured file.

After you create these Xstart files, you can manage their distribution. For 
example, you can create two Xstart files, each with different startup 
methods, and distribute them to users as required.

To create an Xstart file:

1 Start Exceed onDemand Server Manager and connect to Exceed 
onDemand Server.

2 Use the tree pane to access the Xstart file space in which you want to 
create a new Xstart file. You can create either a global or a user-specific 
Xstart file.

Tree pane with user-specific 
Xstart file space selected
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3 Do one of the following to create a new Xstart file that you will then 
customize:

• Click the information pane. On the Edit menu, click New Xstar t File.

• Right-click the information pane. On the pop-up menu, click New 
XStart File.

To change the name of an 
Xstart file, select it and 
click Rename on the Edit 
menu.

• If one or more Xstart files already exist, select one and click Copy on 
the Edit menu to create a new Xstart file with the same settings. 
Alternatively, right-click the Xstart file and click Copy from the 
pop-up menu. Modify the name of the Xstart file if necessary.

4 Select the Xstart file, and click Modify on the Edit menu. The 
Exceed onDemand Xstart dialog box opens. 

5 Select a startup method.
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6 To configure the selected startup method, click Settings. The Xstart 
Settings dialog box opens. Setting availability is determined by the 
startup method you selected.

7 When you have made all the necessary modifications, click OK to return 
to the Exceed onDemand Xstar t dialog box.

8 In the Connection area, specify the host and do one of the following:

• Select Use Exceed onDemand Credentials if you want to use your 
Exceed onDemand Client user ID and password for authentication.

• Select Use Other Credentials and specify a different user ID and 
password in the boxes provided.

9 Type the command you want to run. The type of command depends on 
the host system and how the host is set up.

10 Click Apply, and then click Close.
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Modifying Xstart Files

After you create an Xstart file, you can edit the settings at any time. 
Administrators can also edit the settings for any global or user-specific 
Xstart file.

To change the name of an 
Xstart file, select it and 
click Rename on the Edit 
menu.

To modify an Xstart file:

1 Start Exceed onDemand Server Manager and connect to Exceed 
onDemand Server.

2 Use the tree pane to access the Xstart file you want to edit. You can edit 
either a global or a user-specific Xstart file.

3 In the information pane, select the Xstart file you want to modify.

4 On the Edit menu, click Modify. The Exceed onDemand Xstart dialog box 
opens.

5 If necessary, you can change the startup method and connection 
information.

6 To reconfigure the selected startup method, click Settings. The Xstart 
Settings dialog box opens.

7 When you have made all the necessary modifications, click OK to return 
to the Exceed onDemand Xstar t dialog box.

Naming Xstart Files
When naming an Xstart file, keep the following rules in mind:

• You can use the following characters: Aa-Zz, ‘_’, ‘-’ and ‘.’.

• You cannot use names that consist solely of dots (.).

• You cannot use a name if it already exists (that is, two global Xstart files 
or two user-defined Xstart files cannot share a name, but a global Xstart 
file can have the same name as a user-defined Xstart file).

• You cannot use letter case to differentiate Xstart files on Exceed 
onDemand Servers for Windows. Only UNIX servers are case sensitive.
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To change the name of an Xstart file:

1 Start Exceed onDemand Server Manager and connect to Exceed 
onDemand Server.

2 Use the tree pane to access the Xstart file you want to rename. You can 
rename either a global or a user-specific Xstart file.

3 In the information pane, select the Xstart file you want to rename.

4 On the Edit menu, click Rename.

5 Type the new name, and press Enter on your keyboard. 

Deleting Xstart Files

You can delete an Xstart file, global or user-specific, at any time.

To delete an Xstart file:

1 Start Exceed onDemand Server Manager and connect to Exceed 
onDemand Server.

2 Use the tree pane to access the Xstart file you want to delete. You can 
delete either a global or a user-specific Xstart file.

3 In the information pane, select the Xstart file you want to delete.

4 On the Edit menu, click Delete. In the confirmation dialog box that 
opens, click Yes.
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Managing Xstart File Availability

Exceed onDemand Server Manager lets you control user access to Xstart 
files. When you create a global Xstart file, it is available for use by any user 
with an active account. Global Xstart files cannot be edited by users. You 
can, however, copy or move a global Xstart file to any user’s Xstart file space, 
in which case, the user can make modifications.

You can also copy and move user-specific Xstart files to make them available 
globally or to other selected users.

To distribute Xstart files to users:

1 Start Exceed onDemand Server and connect to Exceed onDemand 
Server.

2 User the tree pane to access the global or user-specific Xstart file you 
want to distribute.

3 On the Edit menu, do one of the following:

• Click Copy To to open the Copy Files dialog box, which lets you place 
an editable copy of the selected Xstart file in any existing Xstart file 
space, global or user-specific.

• Click Move To to open the Move Files dialog box, which lets you 
move the selected Xstart file to any existing Xstart file space, global 
or user-specific. Doing so makes the Xstart file available only to the 
recipient.

4 In the dialog box that opens, select the destination of the Xstart file and 
click OK.
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Confirming Xstart Login Information Before Connecting

You can configure each Xstart file so that the Connection Parameters dialog 
box is displayed whenever you run the file. What is displayed in this dialog 
box depends on the Local Prompts options you selected on the Star tup page 
of the Xstart Settings dialog box.

If you selected the Show Only or Ask User options, then when you start an 
X session, the Connection Parameters dialog box displays the connection 
information specified in the Xstart file. Depending on the option selected, 
you are prompted to confirm or modify this information. You can configure 
the display of the following items:

• the host you want to connect to

• the user ID

• password

• the command sent to the host

When you click OK in the Connection Parameters dialog box, Exceed 
onDemand attempts to connect.

The Local Prompts area 
lets you configure the 
information displayed or 
requested by the Startup 
Parameters dialog box.
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Chapter 7: Starting an X Session
Overview of X Session Startup

Exceed onDemand Client lets you configure and start X sessions. That is, it 
lets you use your Microsoft Windows PC to access and work with 
X applications that reside on UNIX, Linux, VMS, and other X Window 
System host machines in a configurable environment.

Use the Exceed onDemand Client dialog box to specify the login information 
to establish the connection to the Exceed onDemand Server machine. There 
are a number of ways to start X sessions. The method by which your 
X session starts after Exceed onDemand Client establishes the connection 
depends upon the startup mode settings in the Xconfig file and, optionally, 
the Xstart file selected in the Exceed onDemand Client dialog box. 

You can save the connection information and Xconfig file selection by 
creating connection documents (.eod). Creating connection documents 
gives you the option of starting future X sessions from Windows Explorer, 
from a web page, or from a command line by running the saved files.

Xconfig
The look and behavior of your X session is determined by the settings 
contained in the Xconfig file (.cfg) you select to manage the session. Using 
Xconfig, you can create any number of Xconfig files to accommodate 
different session requirements. Your selection of Xconfig files is saved in any 
connection document (.eod) you create.

Remote Startup with Xstart
In addition to specifying an Xconfig file for your X session, you can specify 
an Xstart file (.xs). Xstart is an application that lets you create, configure 
and manage Xstart files (.xs) for remote logins and automatic 
X application startup. In these files, you specify the X application host to 
which you want to connect, your login credentials for that host, and 
command line parameters necessary to start the X application you require. 
You also specify a startup method: REXEC, RSH, RLOGIN, TELNET, or 
Secure Shell. Whenever you initiate an X session with Exceed onDemand 
Client, you can select from the Xstart files you have created, and run the one 
that is configured to connect you to the proper host and start the required 
X application. As with Xconfig files, your selection of Xstart files is saved in 
any connection document (.eod) you create.
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Connecting to Hosts

The Exceed onDemand Client dialog box opens when you start Exceed 
onDemand. Use it to specify the Exceed onDemand Server machine you 
want to connect to. You must also select the Xconfig file you want to use to 
configure the behavior of an X session. Optionally, you can select an Xstart 
file to connect you to a host and start an X application.

If you experience problems connecting to an Exceed onDemand Server 
installed on Windows XP or Windows Server 2003, see “Troubleshooting 
Connections to Exceed onDemand Server” on page 59.

For detailed information 
about the Exceed 
onDemand Client dialog 
box, see Help.

To start an Exceed onDemand session:

1 In the Exceed onDemand Client dialog box, provide the information 
required to log into the Exceed onDemand Server machine.

Note: If Exceed onDemand Server is installed on a Windows 
platform, and your computer is on a domain, provide the domain 
name and user name as follows:

domain\username

If your computer belongs to a work group, specify the group in 
place of the domain.
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If you want to view or edit 
the settings in an Xconfig 
or Xstart file, click the 
adjacent browse button 
(...). In the dialog box that 
opens, select the file you 
want to view and click 
Settings.

2 In the Configuration area, select an Xconfig file (.cfg) from the Xconfig 
drop-down list, if necessary.

3 If you want to use a remote startup method, select an Xstart file (.xs) 
from the Xstar t drop-down list.

4 Click the Run button.

• If the Suspended Sessions dialog box opens, you can select a session 
you want to resume, or opt to start a new session. For more 
information, see Help.

• If the Active Sessions dialog box opens, you can reuse a currently 
running session (proxy) to start the X application, or you can start 
another session (proxy). For more information, see Help.

The remaining steps and the look of the session depend on the settings in 
the Xstart and/or Xconfig files you select. For more information on startup 
mode behavior, see Exceed onDemand Help.

Creating Connection Documents
In the Exceed onDemand Client dialog box, you can create and edit 
connection documents (.eod). These files store the login and configuration 
information you specify for connecting to Exceed onDemand Server and 
launching an X session. By default, connection documents are saved locally 
in the Exceed onDemand Client directory for a particular user. For 
example:

C:\Documents and Settings\user\Application Data\ 
Hummingbird\Connectivity\5.0\Exceed onDemand\Client\

To create a new connection document:

1 In the Exceed onDemand Client dialog box, specify the connection 
parameters necessary to connect to the Exceed onDemand Server 
machine.

2 Click the Save button. The Save As dialog box opens. 

3 Provide a name for the connection document by editing the default file 
name, NewConnection.eod, which appears in the File name box. 
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4 If necessary, change the default file location.

5 Click Save.

Editing Connection Documents
After you create a connection document (.eod), you can edit it from the 
Exceed onDemand Client dialog box at any time.

To edit a connection document:

1 In the Exceed onDemand Client dialog box, click the Open button.

2 Select the connection document you want to edit, and then click Open. 
The Exceed onDemand Client dialog box displays the connection 
parameters for the connection document you selected.

3 Edit the parameters you want to change.

4 Click the Save button.

Launching Exceed onDemand from a Command Line

For information on creating 
connection documents, 
see “Creating Connection 
Documents” on page 113.

In addition to starting an Exceed onDemand session from the desktop or 
from Windows Explorer, you can start a session from a command line. You 
can also start a session using an existing connection document, which has 
the extension .eod and contains parameters specified in the Exceed 
onDemand Client dialog box. When you use a connection document to 
launch an X session, Exceed onDemand uses the connection parameters 
saved in the file to start the session.

The command line syntax is as follows:

[path1/]ExceedonDemand.exe [parameters]

Note: Saving to the default location ensures that future versions of 
Exceed onDemand Client can access it.
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where path1 is the directory where you installed Exceed onDemand Client 
and parameters is any of the following (alphabetic characters can be upper 
or lower case): 

Parameter Description

-configopts OR
-xstartopts OR
-e

Provided that you have specified all connection 
parameters necessary to launch an X session (either 
through the command line or a connection 
document), you can use the following parameters to 
specify how you want to launch Exceed onDemand 
Client:

• Specify -configopts to launch the Exceed 
onDemand Xconfig dialog box.

• Specify -xstartopts to launch the Exceed on 
Demand Xstart Settings dialog box.

• Specify -e to launch the Exceed onDemand Client 
dialog box. All connection parameters specified in 
the command line and/or connection document 
are automatically displayed in the dialog box.

Specify only one of the three parameters listed 
above. If you specify more than one parameter, then 
the last one you specify takes precedence.

If no parameters are specified, Exceed onDemand 
Client automatically launches the X session. If you 
do not specify all required connection parameters, 
the Exceed onDemand dialog box opens, prompting 
you for any missing information. For more 
information, see “Connecting to Hosts” on 
page 112.

-d Specifies that you want Exceed onDemand Client to 
delete a connection document, if one is specified in 
the command line, once it has read all login and 
connection parameters from the file.

-h hostname The name of the host (Exceed onDemand Server 
machine) to which you want to connect.

-u username The user name with which you want to connect to 
the host.
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-p password OR
-pp encryptedpassword

The password with which you want to connect to the 
host. You can specify a password that is either 
encrypted or not encrypted:

• Use -p password to specify a non-encrypted 
password.

• Use -pp encryptedpassword to specify a 
password that is encrypted in the format found in 
the connection document used to launch an 
X session. For more information, see “Creating 
Connection Documents” on page 113.

-c xconfig The name of the Xconfig file with which you want to 
launch an X session.

-x xstart The name of the Xstart file with which you want to 
launch an X session.

[--] [path2/] 
connect.eod

The name of the connection document with which 
you want to launch an X session, where path2 is the 
directory where the connection document is located. 
Specify only one connection document.

If a file or path name contains spaces, you must 
enclose it in quotation marks.

Note: If you choose to precede the name of the 

connection document with “--”, Exceed onDemand 

treats everything, including spaces, that follows the 

“--” as the connection document path. For this 

reason, you do not need to enclose file or path 
names that contain spaces with quotation marks.

Note: When specifying parameters, keep the following in mind:

• You can precede a parameter with a “/” rather than a “-”. For 
example, /u user is equivalent to -u user.

• Connection parameters specified in the command line take 
precedence over connection parameters specified in a 
connection document.

• You can assign an empty value to a parameter by specifying 
an empty string (““).

Parameter Description
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For example, you can type the following to immediately launch an X session 
that uses all connection parameters specified in connect.eod, with the 
exception of the host parameter:

exceedondemand.exe -h eodhost -- C:\User Settings
\username\Client\connect.eod

In the above example, Exceed onDemand connects to the host specified in 
the command line, eodhost, rather than the one specified in connect.eod 
because parameters specified in the command line take precedence over 
ones specified in a connection document.

Launching Sessions from Web Pages

For information on creating 
connection documents, 
see “Creating Connection 
Documents” on page 113.

You can place a link on any web page to start an Exceed onDemand session 
based on the parameters stored in a connection document (.eod). Use the 
following syntax in the link definition:

<a href=”connect.eod” type=application/eod>Run EOD</a>

where:

• connect.eod is the connection document you want Exceed onDemand 
to use when launching the session.

• Run EOD is the text link that appears on the web page.

Logging Off Exceed onDemand

When you are ready to end an Exceed onDemand session, exit all 
X applications and window/desktop managers first. The Exceed onDemand 
logoff process differs from this point onward depending on the startup 
mode specified in the Xconfig file used to start the X session.

If you want to perform a server reset, you do not have to log off Exceed 
onDemand. To reset the server, point to Tools on the Exceed onDemand 
Desktop menu and click X Server Reset.
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To log off Exceed onDemand, do one of the following:

• If the XDMCP Display Manager Chooser dialog box opens, click Exit. This 
dialog appears for sessions started in XDMCP Broadcast startup mode. 
It appears also if XDMCP Indirect is the startup mode, and the Select 
First Display Manager option is not enabled.

• Click Close on the Exceed onDemand Desktop menu.

When you are prompted to confirm the log off, click OK to end the 
X Window session, or click Suspend if you intend to resume the session 
later.

Note: If the Select First Display Manager option is enabled, 
Exceed onDemand reopens the host login screen automatically 
after you exit all X applications and window/desktop managers. If 
this occurs, click Close on the Desktop menu to log off Exceed 
onDemand. For more information on configuring XDMCP startup 
modes, see “About Xconfig” on page 87.
118



Chapter 8

Working with X Sessions

Changing the Interface Language 121

Viewing Information About Your X Sessions 122

Displaying the Exceed onDemand Desktop Menu 122

Displaying the Connection Document Context Menu 123

Resetting the X Server 123

Switching Between X Windows and Windows 124

Printing with Exceed onDemand Client 124
Printing Files from the UNIX Command Line 125
Printing Files from X Applications 128

About Copying and Pasting 130

About Text Selections 131
Copying and Pasting Text to and from the Clipboard 132
Copying Text to a Printer 134
Copying and Pasting Text to and from Files 134

About Active Client Window Selections 136
Copying Graphics to the Clipboard 136
Copying Graphics to a Printer 137
Copying Graphics to a File 137

About Sharing X Sessions 138
Sharing X Sessions  139
Editing the Share List 140
Participating in Shared Sessions 140



About X Session Suspend/Resume 141
Suspending X Sessions 142
Defining Automatic Suspend Settings 143
Resuming X Sessions 143
Terminating Suspended X Sessions 144
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This chapter provides information aimed to help orient you with the Exceed 
onDemand Client interface. You will also find procedures for some 
common tasks and commonly used features. For more information, see 
Exceed onDemand Client Help.

Changing the Interface Language

You have the option of changing the language of the user interface before 
you connect to the host. The languages from which you can choose are 
determined during installation.

To change the language of the Exceed onDemand Client interface:

1 In the Exceed onDemand Client dialog box, open the Settings menu, click 
Language and then select the language you want Exceed onDemand 
Client to display for its interface.

Alternatively, you can click Auto Detect to configure Exceed onDemand 
Client to use the same language as the operating system for the current 
user only. In this scenario, the application will read the Windows 
display language setting and match it if that language is installed.

2 Proceed with connecting to the host.

Note: 

• The language you select is applied only to the Exceed 
onDemand Client user interface. Default system dialog boxes 
and X applications are not affected.

• If Exceed onDemand Client was installed for all users on a 
machine, then the default language specified during 
installation takes precedence over language settings specified 
in Language Chooser each time a new user launches Exceed 
onDemand Client.

• If, using Language Chooser, you set the default language to 
match that of the operating system and you proceed to install 
Exceed onDemand Client, the default language specified 
during installation takes precedence over language settings 
specified in Language Chooser.
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Viewing Information About Your X Sessions

The title bar, located at the top of the Exceed onDemand Desktop, displays 
session information. In multiple window mode, you can view this 
information by placing the mouse pointer over the Exceed onDemand 
taskbar icon.

Use the title bar to view the following:

• Determine the display specification you need to specify when starting 
an X application. The information is in the following form:

hostname:displayID(ipaddress:displayID)-Exceed onDemand 
Desktop-xconfigfilename-owner

For example:

eodhost:2(123.183.33.17:2)-Exceed onDemand Desktop-
GlobalXconfig.cfg-psmith

• Determine whether or not the connection is SSL encrypted. When 
encryption is on, the word secure appears in parentheses on the Exceed 
onDemand title bar.  

Displaying the Exceed onDemand Desktop Menu

The Exceed onDemand Desktop menu lets you perform copy and paste 
functions, server resets, and traces. It also provides access to various log files 
and to Xconfig which let you configure your X session.

Note: To view SSL cipher information, consult the client or proxy 
log file, which you can open from the Exceed onDemand Desktop 
menu. For more information, see “Displaying the Exceed 
onDemand Desktop Menu” on page 122.

Note: Most menu items are not available if you are running a 
session that has been shared to you.
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To display the Exceed onDemand Desktop menu, do one of the following:

• right-click the Exceed onDemand Desktop title bar

• right-click the Exceed onDemand taskbar icon

Displaying the Connection Document Context Menu

To view this menu, right click the connection document (.eod file) icon if 
you have created one on your desktop.

Resetting the X Server

You can reset the X server at any time to terminate all X applications and 
start a new session.

To reset the X server:

1 Save your work.

2 Exit all X applications and window managers.

3 On the Exceed onDemand Desktop menu, click Tools, and then click 
X Server Reset.

4 Click OK.

Note: In multiple window mode, you can access this menu only by 
right-clicking the Exceed onDemand taskbar icon.

Note: After making changes to Xconfig settings, you are 
prompted to reset the X server. In this case, you can reset from the 
dialog box by clicking OK.
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Switching Between X Windows and Windows

In multiple window mode, you can switch between X Window backdrop 
and Windows desktop.

To toggle between the X Window backdrop and Windows desktop:

On the Exceed onDemand Desktop menu, click Tools, and then click Toggle 
Backdrop.

Printing with Exceed onDemand Client

With Exceed onDemand Client, you can access files and print them as you 
would a local file. Hummingbird Exceed onDemand Print Utility (elpr) is 
the program that facilitates this functionality.

You can use elpr from the command line, or configure X applications to use 
elpr as the default printer. Exceed onDemand supports printing of only 
printable files, which are plain text (.txt) files, and, depending on the 
printer, PostScript (.ps) files. You can also print images. All other files are 
unsupported by Exceed onDemand printing, and are considered as 
non-printable files.

Note: elpr is provided on the Exceed onDemand CD. In order to 
enable printing, system administrators must copy or install elpr to 
each machine running X applications from which users need to 
print.

Note: Most UNIX applications can produce PostScript-formatted 
output, but many printers do not support this file type. In such 
cases, you can use third-party applications to convert the 
PostScript to a supported format.
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When you print from an X session, the files that you want to print are first 
transferred from your X session to the Exceed onDemand Server. You can 
then access and print the files at any time using the Server Files dialog box. 
Non-printable files must first be opened in a valid application, and then 
printed from within the application.

To print a file from an X session:

1 Use elpr to transfer the file that you want to print from your X session 
to Exceed onDemand Server, using any of the following methods:

• transfer files from a UNIX command line

• transfer files from an X application

All files that are sent to the server are listed in the Server Files dialog box. 
You can access the Server Files dialog box by clicking File on the Exceed 
onDemand Desktop menu and then clicking Server Files.

2 In the Server Files dialog box, select a file and print it as you would a 
local file.

Printing Files from the UNIX Command Line
If the file that you want to print is saved on your UNIX machine, then you 
can use the elpr command to send the file from your X session to Exceed 
onDemand Server, and then print it as you would a local file.

To print from the UNIX command line:

1 Enable printing and specify the appropriate printing behavior for your 
X session. For more information, see Exceed onDemand Help.

2 Transfer the file that you want to print from your X session to Exceed 
onDemand Server using the elpr command:

> elpr filename

where filename is the name of the file you want to print.

Depending on which When Print Job(s) Available option is enabled on 
the Printing page of the Exceed onDemand Xconfig dialog box, the Server 
Files dialog box may or may not open to prompt you to select a file for 
printing. If the dialog box does not open automatically, you can access it 
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by clicking File and then Server Files from the Exceed onDemand 
Desktop menu. The icons to the left of the file name in the dialog box 
indicate the file’s printability. For more information, see Exceed 
onDemand Help.

3 In the Server Files dialog box, select the file that you want to print and 
then select the appropriate file format:

• Auto—Exceed onDemand attempts to select the appropriate file 
format.

• Binary—Recommended for printing file types other than text.

• ASCII—Recommended for printing text files (.txt or.ps).

Note: If you enabled Print Automatically for the When Print Job(s) 
Available option on the Printing page of the Exceed onDemand 
Xconfig dialog box, then all printable files are automatically sent to 
the default printer. The Server Files dialog box does not appear, 
and you are not required to select files for printing. If no default 
printer is specified, then you are prompted to select one.

If the Server Files dialog box is already opened, then a 
confirmation message appears. For printable files, click Yes to 
begin printing the file, or click No to cancel printing and update 
the Server Files dialog box with a new list of print files. For non-
printable files, click Yes to print all printable files on the server, or 
click No to cancel printing and update the Server Files dialog box 
with a new list of print files.
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4 Print the selected file by doing the following:

• To print a printable file (a .txt or .ps file), click Print. The selected 
file is automatically sent to the default printer. Alternatively, you 
can click Open or Save to preview or save the file to your local 
machine before printing the file.

• To print a non-printable file (a file other than .txt or .ps), you 
must first open the file using an application that supports it by 
clicking Open. You can then print the file from within the 
application. Alternatively, you can click Save to save the file to your 
local machine before opening and printing the file.

Note: 

• Text files are always printed on the default printer. If Exceed 
onDemand Client is installed on Windows 98/Me, the ability to 
print text files depends on whether the file can be associated 
with a local application, such as Microsoft Notepad, which 
handles the format. If no association exists, then the Print 
button is not available. You can either open or save the file.

• All other printable files open a standard print dialog box that 
allows you to designate a printer for the job.

• If you select and print a combination of text and non-text files, 
a standard print dialog box opens. The non-text files are sent 
to the printer you specify, and the text files are sent to the 
default printer.
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Printing Files from X Applications
If you are running an X application such as a browser, you can use the 
application’s print function to send a file to the Exceed onDemand Server 
and then print it as you would a local file.

To print from an X application:

1 Enable printing and specify the appropriate printing behavior for your 
X session. For more information, see Help.

2 Find the location of elpr on your UNIX machine by asking your system 
administrator, or by using the which command:

> which elpr

3 Open the file you want to print in an application associated with its file 
type, and click Print.

4 In the print dialog box that opens, edit the print command by 
specifying the location of elpr. For example:

/user/local/bin/elpr

If you want to give the file a .ps extension, edit the command as follows:

/user/local/bin/elpr -ext .ps

If you want to disable any information messages, edit the command as 
follows:

/user/local/bin/elpr -ext .ps -q

Note: The following procedure is generic. The print feature in the 
application from which you want to print may operate differently.
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5 Click Print. The file is automatically sent to the Exceed onDemand 
Server.

Depending on which When Print Job(s) Available option is enabled on 
the Printing page of the Exceed onDemand Xconfig dialog box, the Server 
Files dialog box may or may not open to prompt you to select a file for 
printing. If the dialog box does not open automatically, you can access it 
by clicking File and then Server Files from the Exceed onDemand 
Desktop menu. The icons to the left of the file name in the dialog box 
indicate the file’s printability. For more information, see Exceed 
onDemand Client Help. 

6 In the Server Files dialog box, select the file that you want to print and 
then select the appropriate file format:

• Auto—Exceed onDemand attempts to select the appropriate file 
format.

• Binary—Recommended for printing file types other than text.

• ASCII—Recommended for printing text files (.txt or .ps).

Note: If you enabled Print Automatically for the When Print Job(s) 
Available option on the Printing page of the Exceed onDemand 
Xconfig dialog box, then all printable files are automatically sent to 
the default printer. The Server Files dialog box does not appear, 
and you are not required to select files for printing. If no default 
printer is specified, then you are prompted to select one.

If the Server Files dialog box is already opened, then a 
confirmation message appears. For printable files, click Yes to 
begin printing the file, or click No to cancel printing and update 
the Server Files dialog box with a new list of print files. For non-
printable files, click Yes to print all printable files on the server, or 
click No to cancel printing and update the Server Files dialog box 
with a new list of print files.
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7 Print the selected file by doing the following:

• To print a printable file (a.txt or .ps file), click Print. The selected 
file is automatically sent to the default printer. Alternatively, you 
can click Open or Save to preview or save the file to your local 
machine before printing the file.

• To print a non-printable file (a file other than .txt or .ps), you 
must first open the file using an application that does support it. To 
do this, click Open. You can then print the file from within the 
application. Alternatively, you can click Save to first save the file to 
your local machine before opening and printing the file.

About Copying and Pasting

Exceed onDemand supports data copying and pasting between 
X applications, and the operating system’s native clipboard and 
applications. Pasting from X applications to printers is also supported. The 
copy and paste process uses a temporary buffer to hold data. A snapshot of 
the data stays in the buffer until it is cleared or replaced. The buffer which 
holds the data differs depending on whether you are using applications 
native to the operating system (for example, Windows).

Note: 

• Text files are always printed on the default printer. If Exceed 
onDemand Client is installed on Windows 98/Me, the ability to 
print text files depends on whether the file can be associated 
with a local application, such as Microsoft Notepad, which 
handles the format. If no association exists, then the Print 
button is not available. You can either open or save the file.

• All other printable files open a standard print dialog box that 
allows you to designate a printer for the job.

• If you select and print a combination of text and non-text files, 
a standard print dialog box opens. The non-text files are sent 
to the printer you specify, and the text files are sent to the 
default printer.
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Applications native to an operating system typically use a buffer called the 
clipboard to perform the copy/paste function. In the X Window 
environment, copy/paste data is stored in an X selection buffer with a 
specific name.

The X application performing a copy/paste operation determines which 
X selection(s) to use and how to use it. You need to determine which 
X selection your X application uses to copy data and which X selection it 
uses to paste data.

Most X applications use the PRIMARY X selection for both the copy and 
paste operations, but other selections, such as SECONDARY, CLIPBOARD, 
and CUT_BUFFER0 to CUT_BUFFER7, are also defined. You also need to 
determine how to copy data displayed in your X application window into 
the X selection buffer and how to paste data from the X selection buffer into 
your X application window.

The Input options offer 
middle-mouse button 
emulation. See Help for 
more information.

Most X applications copy any data you select with your mouse into the 
X selection buffer associated with the copy operation. Some X applications 
require you to enter a keystroke combination or to select a copy menu 
command before copying the currently selected data into the X selection 
buffer. Pasting usually occurs at the insertion point when you click your 
middle-mouse button in the window, select a paste menu command, or 
enter a paste keystroke combination.

About Text Selections

For information on how to 
display the Exceed 
onDemand Desktop menu, 
see “Displaying the 
Exceed onDemand 
Desktop Menu” on 
page 122.

You can copy/paste text between an X selection and the operating system 
clipboard, a destination file, or the default printer using the Edit menu 
commands available on the Exceed onDemand Desktop menu. 

There are copy and paste procedures for two scenarios:

• copying and pasting text between an X application and an operating 
system native application

• copying and pasting text between X applications
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Copying and Pasting Text to and from the Clipboard

To copy text from an X application to an operating system native 
application:

1 Configure Exceed onDemand for the X selection your X application 
uses for copy operations. For more information, see Exceed onDemand 
Help.

2 In your X application, select the text that you want to copy.

3 If required by your X application, type a keystroke combination, or 
select the Copy menu command on the X application to copy the 
currently selected text into the X selection buffer. Many X applications 
automatically copy when you release the mouse button after text 
selection.

For information on how to 
display the Exceed 
onDemand Desktop menu, 
see “Displaying the 
Exceed onDemand 
Desktop Menu” on 
page 122. 

4 On the Exceed onDemand Desktop menu, click Edit, Copy X Selection, 
and then To Clipboard. If you are using the native window manager in 
multiple window mode, you can also access these features on the 
X application system menu. The text selection is transferred to the 
operating system clipboard. You can paste the text stored in the 
clipboard into one or more operating system native applications.

To paste text into an X application from the operating system clipboard:

1 Configure Exceed onDemand for the X selection your X application 
uses for paste operations. For more information, see Exceed onDemand 
Help.

2 In your operating system native application, select and copy the text 
that you want to copy using the method specific to your application. 
The text selection is transferred to the operating system clipboard.

3 On the Exceed onDemand Desktop menu, click Edit. Click Paste To 
X Selection and select From Clipboard. If you are using the native window 
manager in multiple window mode, you can also access these features 
on the X application system menu. The text from the clipboard is 
transferred to the currently configured X selection. 
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4 Paste the text from the X selection into your X application window 
using the method specific to your X application. Typically, the text is 
pasted to your X application window at the insertion point when you 
click the middle-mouse button. Otherwise, in the X application 
window, select a paste menu command or type the paste keystroke 
combination.

5 Repeat step 4 to paste the text stored in the X selection into one or more 
X application windows, provided the target X applications support the 
same X selection for paste operations.

To copy and paste text between X applications displayed on Exceed 
onDemand desktop:

1 Configure Exceed onDemand for the X selection your X application 
uses for copy/paste operations. For more information, see Exceed 
onDemand Help.

2 Select the X application text you want to copy.

3 If required by your X application, type a keystroke combination or 
select the X application copy menu command to copy the currently 
selected text into the X selection buffer. Many X applications 
automatically copy when you release the mouse button after text 
selection.

4 Paste the text from the X selection into your X application window 
using the method specific to your X application. Typical X applications 
paste the text X selection into their window, usually at the insertion 
point, when you click the middle-mouse button. In the X application 
window, select a paste menu command or type the paste keystroke 
combination.

5 Repeat step 4 to paste the text stored in the X selection into one or more 
X application windows, provided the target X applications support the 
same X selection for paste operations.

Note: To perform this procedure, the X applications must support 
the same X selection for copy/paste operations.
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Copying Text to a Printer

To copy text from an X application to the default printer:

1 Configure Exceed onDemand for the X selection your X application 
uses for copy operations. For more information, see Exceed onDemand 
Help.

2 Select the X application text you want to copy.

3 If required by your X application, type a keystroke combination, or 
select the copy menu command on the X application to copy the 
currently selected text into the X selection buffer. Many X applications 
automatically copy when you release the mouse button after text 
selection.

For information on how to 
display the Exceed 
onDemand Desktop menu, 
see “Displaying the 
Exceed onDemand 
Desktop Menu” on 
page 122. 

4 On the Exceed onDemand Desktop menu, click Edit, Copy X Selection, 
and then To Printer. If you are using the native window manager in 
multiple window mode, you can also access this feature on the X client 
system menu. The text from the currently configured X selection is 
automatically transferred to the default printer.

Copying and Pasting Text to and from Files

To copy text from an X application to a destination .txt file:

1 Configure Exceed onDemand for the X selection your X application 
uses for copy operations. For more information, see Exceed onDemand 
Help.

2 Select the X application text you want to copy.

3 If required by your X application, type a keystroke combination, or 
select the Copy menu command on the X application to copy the 
currently selected text into the X selection buffer. Many X applications 
automatically copy when the mouse button is released after text 
selection.
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For information on how to 
display the Exceed 
onDemand Desktop menu, 
see “Displaying the 
Exceed onDemand 
Desktop Menu” on 
page 122. 

4 On the Exceed onDemand Desktop menu, click Edit, Copy X Selection, 
and then To File. If you are using the native window manager in multiple 
window mode, you can also access this features on the X application 
system menu. In the Copy X Selection To File dialog box that opens, 
browse to the local directory where you want to place the file, and click 
Save. The text from the configured X selection is copied to the 
destination .txt file.

To paste text from a .txt file to an X application:

1 Configure Exceed onDemand for the X selection your X application 
uses for paste operations. For more information, see Help.

2 On the Exceed onDemand Desktop menu, click Edit, Paste To 
X Selection, and then From File. If you are using the native window 
manager in multiple window mode, you can also access this feature on 
the X application system menu. In the Paste File To X Selection dialog 
box that opens, select a file. The text from the selected file is transferred 
to the currently configured X selection.

3 Paste the text from the X selection into your X application window 
using the method specific to your X application. Typical X applications 
paste the text X selection into their window, usually at the insertion 
point, when you click the middle-mouse button. In the X application 
window, select a paste menu command or type the paste keystroke 
combination.

4 Repeat step 3 to paste the text stored in the X selection into one or more 
X client windows, provided the target X applications support the same 
X selection for paste operations.

Note: By default, the text X selection is saved as a .txt file.
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About Active Client Window Selections

You can copy regions in the active client window to the operating system 
clipboard, a destination file, or the default printer using the following Edit 
menu commands available on the Exceed onDemand Desktop menu. For 
more information, see “Displaying the Exceed onDemand Desktop Menu” 
on page 122.

Copying Graphics to the Clipboard

To copy graphics from an X application to an operating system native 
application:

1 On the Exceed onDemand Desktop menu, do one of the following:

• To select a region of the active client window, click Edit, Copy 
Rectangle, and then To Clipboard. The mouse cursor changes to a 
camera. Use the tip of the camera lens to select the desired region of 
the window by holding down the left mouse button and dragging. 
When you release the mouse button, the outlined area of the 
window is transferred to the operating system clipboard.

• To copy all visible parts of the active client window, click Edit, Copy 
All, and then To Clipboard on the Desktop menu. All regions of the 
window are copied and transferred to the operating system 
clipboard.

2 You can paste the graphic stored in the clipboard into one or more 
operating system native applications that support pasting graphics.

Note: Exceed onDemand currently supports only the copying of 
regions from the active client window. Pasting of graphics is not 
supported.

Note: If you are using the native window manager in multiple 
window mode, you can also access these features on the 
X application system menu.
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Copying Graphics to a Printer

To copy graphics from an X application to a printer:

1 On the Exceed onDemand Desktop menu, do one of the following:

• To select a region of the active client window, click Edit, Copy 
Rectangle, and then To Printer. The mouse cursor changes to a 
camera. Use the tip of the camera lens to select the desired region of 
the window by holding down the left mouse button and dragging. 
When you release the mouse button, the Copy To Printer dialog box 
opens.

• To print all visible parts of the active client window, click Edit, Copy 
All, and then To Printer on the Desktop menu. The Copy To Printer 
dialog box opens.

2 In the Copy To Printer dialog box, specify the appropriate scaling options 
that you want, and click Print. The selected region is transferred to the 
default printer. To abort the operation at any time, click Cancel or press 
Escape on your keyboard.

Copying Graphics to a File

To copy graphics from an X application to a destination .bmp file:

1 On the Exceed onDemand Desktop menu, do one of the following:

• To select a region of the active client window, click Edit, Copy 
Rectangle, and then To File. The mouse cursor changes to a camera. 
Use the tip of the camera lens to select the desired region of the 
window by holding down the left mouse button and dragging. 
Release the mouse button to copy the selected region.

Note: If you are using the native window manager in multiple 
window mode, you can also access these features on the 
X application system menu.
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• To copy all visible parts of the active client window, click Edit, Copy 
All, and then To File.

2 In the Save Bitmap As dialog box that opens, browse to the local 
directory where you want to place the file, and click Save. The selected 
region or window is copied to the destination .bmp file.

About Sharing X Sessions

The Share feature lets you share your X session to one or more users, so that 
they may either view or participate in the session from their computers 
depending on the permissions you grant to each user. This feature is useful 
if you are providing a demonstration, working remotely, or getting technical 
support.

A Share list resides in the Other options of each Xconfig file. This file lists the 
users to whom you want to grant access. It also specifies the type of access 
you want to grant (view-only or participate). Exceed onDemand Share List 
Editor lets you edit the share list in two ways: 

• For the current session only—The list is applied only to the current 
X session. Your modifications to the list are not saved in the Xconfig file 
you selected to start the session. 

• For all sessions that use a specific Xconfig file—Your modifications to 
the list are saved as part of an Xconfig file. Whenever you select that file 
for an X session, Exceed onDemand applies the saved Share list.

You cannot save Share list changes to a Global Xconfig file unless you are an 
administrator with access to Exceed onDemand Server Manager.

Note: If you are using the native window manager in multiple 
window mode, you can also access these features on the 
X application system menu.

Note: Sharing is not available in Multiple Window mode.
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Sharing X Sessions 
This procedure gives you the option of applying your Share list 
modifications to the current session only, or saving your changes to the 
Share list in an Xconfig file for future use.

To share a session:

1 Start an Exceed onDemand session by connecting to a host. Keep in 
mind that the Xconfig file you select when connecting will be modified 
if you decide to save your changes to the Share list.

2 Ensure that sharing is enabled. On the Exceed onDemand Desktop 
menu, click Session, Share, and then Edit Share List. The Share List Editor 
dialog box opens.

3 Click Add. 

4 In the Share list, type the name of the user to whom you want to share 
the session and press Enter. Use the following syntax:

• for Windows servers—domain\username. The domain may also be 
the local PC where Exceed onDemand Server is installed.

• for UNIX/Linux servers—username.

Note: 

• If the Xconfig file you use to start the session is a global file, 
you cannot save your Share list changes. They will be effective 
only for the duration of the session you start.

• You cannot share sessions to users who are using a different 
version of Exceed onDemand Client.

• When you start an X session, if you select an Xconfig file 
configured to enable OpenGL support, you cannot share the 
session to another user, especially if you intend to run a 3D 
application. For more information, see Exceed onDemand 
Help.
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5 Select one of the following permission types in the Permission Area:

• View Only—Permits the specified user to observe all the actions you 
perform in your session. The user cannot participate in the session.

• Participate—Permits the specified user to participate in the session. 
It does not enable the user to change Xconfig file options, print, 
suspend the session, or reset the server.

Alternatively, right-click the added user. On the pop-up menu, click 
Permission, and select the permission type.

6 Click OK. The Share list is applied to the current session.

Editing the Share List
You can rename or remove a user from the share list at any time by opening 
the Share List Editor dialog box, selecting the user and clicking Rename or 
Remove. Alternatively, right-click a user and select the appropriate option 
from the pop-up menu.

Participating in Shared Sessions
If you have access to a shared session, you can open it from the Sharable 
Sessions dialog box. To start a shared session, you must have access to the 
server from which it is shared.

To start a session shared to you by another user:

1 In the Exceed onDemand Client dialog box, provide the information 
necessary to connect to the server.

2 On the Action menu, click Share. If one or more users have shared their 
sessions to you, the Sharable Sessions dialog box opens listing the 
shared sessions that are currently running on the host. You can also 
view status and permission information.

3 Select the session that you want to access and click Share.

Note: If you experience a delay while Exceed onDemand 
connects to the server, it is likely that the master session is 
involved in an X application operation such as CDE login. Exceed 
onDemand will connect when the operation is complete.
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Working in Shared X Sessions
If you have Participate permission in a session shared to you by another 
user, you can participate in the session unless otherwise indicated by the 
control icons in the status area (system tray). These icons appear only while 
a session is being shared. The following table describes the control icons and 
their uses. 

About X Session Suspend/Resume

Suspend/Resume lets you end an X session on your PC without terminating 
the X applications you are using. When you suspend an X session, Exceed 
onDemand Server maintains it so that, when you log back into that server, 
you have the option of resuming the session and restarting the 
X applications you require. If you do not want to resume a session, you also 
have the option of terminating it and/or starting a completely new one.

Additional Suspend/Resume settings located in your Xconfig file let you 
safeguard your work against unwanted disconnections, and suspend 
sessions without terminating the X applications you were running. 

The Available icon indicates that all users can gain control of 
the X session by providing input (typing or using the mouse 
within the session). It appears by default on all client desktops 
running the shared session. You can click this icon to secure 
sole control. In this case, all other shared sessions display the 
No-Access icon.

The Control icon appears on your desktop when you click the 
Available icon. It indicates that you have sole control of the 
X session. In this case, the No-Access icon appears on all 
other client desktops running the shared session. You can click 
the Control icon again to make the session available to all 
users.

The No-Access icon indicates that another user has control of 
the X session. In this case, you cannot participate in the 
session unless the user makes the session available.
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To access Suspend/Resume functionality, the following must be true:

• The administrator has enabled Suspend/Resume on the Exceed 
onDemand Server machine you logged into.

• The administrator has specifically granted you Suspend\Resume 
privileges.

Depending on the privileges granted to you, you may also be able to resume 
a session on a machine other than the one on which it was suspended.

Suspending X Sessions
You can suspend an X session at any time if the system administrator has 
enabled the feature. This feature is helpful if you want to resume your 
X Windows session at a later time. All session settings and opened 
X applications are saved.

To suspend a session, do one of the following:

For more information on 
this menu, see “Displaying 
the Exceed onDemand 
Desktop Menu” on 
page 122.

• On the Exceed onDemand Desktop menu, point to Session, and click 
Suspend.

• When closing the session, click Yes in the confirmation dialog box. This 
confirmation dialog box appears only when Close Warning On Exit is 
selected on the Screen page of the Exceed onDemand Xconfig dialog box.

Note: 

• If the X application is in the middle of a task, and you want that 
task to continue while the session is suspended, you must 
ensure that the Keep Suspended Session Active option is 
enabled in the Other tab of the Xconfig file. For more 
information, see Exceed onDemand Help.

• Suspended sessions occupy resources on the server. If a large 
number of sessions are suspended, server performance can 
be affected.

• Exceed onDemand does not support the resuming of OpenGL 
applications. Therefore, if you suspend a session in which one 
or more OpenGL applications are opened and you resume 
that session at a later time, all but the OpenGL applications will 
be properly displayed on screen.
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Defining Automatic Suspend Settings
In some situations, you may want Exceed onDemand to automatically 
suspend X sessions. For example, in the event of a network failure, you may 
lose work in progress on an X application. You can, however, configure 
Exceed onDemand to automatically suspend X sessions upon connection 
loss. X applications are then maintained on the proxy and can easily be 
resumed.

Xconfig files contain settings that let you define which events should trigger 
an automatic suspend. To define these settings, select the appropriate 
Suspending options on the Other page of the Exceed onDemand Xconfig dialog 
box. For more information, see Exceed onDemand Help.

Resuming X Sessions
When you connect to a host on which you suspended an X session, Exceed 
onDemand gives you the option to resume the suspended session.

If enabled by the administrator, you can also resume suspended sessions 
from an Exceed onDemand Client PC other than the one used to suspend 
the session.

To resume a suspended X session:

1 In the Exceed onDemand Client dialog box, specify the login information 
for the host on which you suspended the session. You do not have to 
specify the same Xconfig file used in the suspended session.

2 Do one of the following:

• Click the Run button. If there are no suspended sessions, Exceed 
onDemand connects to the specified host.

• On the Action menu, click Resume.

Note: Exceed onDemand does not support the resuming of 
OpenGL applications. Therefore, if you suspend a session in 
which one or more OpenGL applications are opened and you 
resume that session at a later time, all but the OpenGL 
applications will be properly displayed on screen.
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3 The Exceed onDemand Suspended Sessions - HostName dialog box opens 
and displays all of your suspended sessions. The icons indicate whether 
you can resume a session. Select the session you want to resume and 
click Resume. 

Terminating Suspended X Sessions
Suspended sessions occupy resources on the Exceed onDemand Server 
machine. If a large number of sessions are suspended, server performance 
can be adversely affected. If you do not intend to resume a session again, 
you should terminate it.

To terminate a suspended X session:

1 In the Exceed onDemand Client dialog box, specify the login information 
for the host on which you suspended the session. You do not have to 
specify the same Xconfig file used in the suspended session.

2 Do one of the following:

• Click the Run button. If there are no suspended sessions, Exceed 
onDemand connects to the specified host.

• On the Action menu, click Resume.

3 In the Exceed onDemand Suspended Sessions - HostName dialog box, 
select the unwanted session and click Terminate. In the confirmation 
dialog box that opens, click Yes.

Note: You cannot resume a session if:

• You used a different version of Exceed onDemand Client to 
start and suspend the session.

• The IP address of the suspended session does not match the 
local address, and your user account does not permit you to 
resume such sessions. See your Exceed onDemand 
administrator for more information.
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About Remote Commands

The command line syntax you use to start X applications depends on:

• the X application host’s operating system (typically, UNIX/Linux or 
VMS)

• whether you have defined certain environment variables on your 
X application host

Using Exceed onDemand Macros
You can specify certain display and/or login information using Exceed 
onDemand macros. You can use these macros when specifying commands 
in the following locations:

• The Command text box in the Exceed onDemand Xstar t dialog box.

• The Options box on the Secure Shell page of the Xstart Settings dialog 
box.

• The Reply box located in the Optional Remote Prompt dialog box. (Access 
this dialog box by clicking Add on the Startup page of the Xstart Settings 
dialog box.)
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The following is a list of Exceed onDemand macros. Alphabetic characters 
can be upper or lower case. 

Macro Description

@d Inserts the display specification of the Exceed onDemand Client 
session in the form: ipaddress:display#.

For example, 123.45.67.89:1

@# Inserts the display number of the Exceed onDemand Client 
session.

For example, if 123.45.67.89:1 is your display specification, 
then 1 is the display number.

@a Inserts the address of the Exceed onDemand Client session.

For example, if 123.45.67.89:5 is your display specification, 
then 123.45.67.89 is the address.

@u Inserts the user ID specified in the Authentication area of the 
Exceed onDemand Xstart dialog box. For more information, see 
”Creating Xstart Files” on page 101.

@p Inserts the password specified in the Authentication area of the 
Exceed onDemand Xstart dialog box. For more information, see 
”Creating Xstart Files” on page 101.

@h Inserts the value, as required by the selected startup method, 
specified in the Host box of the Exceed onDemand Xstart dialog 
box. For more information, see ”Creating Xstart Files” on 
page 101.

@w Inserts the Exceed onDemand login.

@c Inserts the IP address of the Exceed onDemand Client machine as 
reported by Exceed onDemand Client.

@s Inserts the IP address of the Exceed onDemand Client machine as 
reported by the Exceed onDemand Server machine.

@@ Specifies the @ character.
148



Appendix A: Command Syntax
Command Line Syntax for UNIX/Linux Hosts
This section describes the commands you use when starting X applications 
on UNIX/Linux hosts.

Use the following command line syntax to start X applications:

[install path]/application [parameters] -display displayspec &

For example, you can type the following to start the xterm X application:

/usr/bin/X11/xterm -sb -ls -fg blue -bg lightgrey -display 
eodhost:2 &

Element Description

install path Specifies the directory where the X application you want to run 
is located.

If you have preconfigured the PATH environment variable on 
your host, then you may not need to enter the path on the 
command line. For more information, see ”Setting 
Environment Variables on UNIX/Linux Hosts” on page 150.

application The executable name of the X application to run.

parameters Any command line parameters you want to specify.

displayspec The display specification of your Exceed onDemand Desktop, 
in the form: hostname:display# or ipaddress:display#.

For example, ewebhost:2 or 123.45.67.89:1. You can 
determine the host name, display number, and IP address to 
use by using information displayed in the Exceed onDemand 
Desktop title bar.

Note: In most cases, you can use @d to specify your 
displayspec.

& Indicates this application should be run in the background.

Note: When starting X applications, it is a good idea to start 
them in background mode.
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With any startup method, you can specify the following command to start 
the xterm X application and to display the user ID and host name in title 
bar of the X application in the form userID@hostname:

/usr/bin/X11/xterm -sb -ls -fg blue -bg lightgrey -display @d 
-name “@u@@@h”&

For more information on using Exceed onDemand macros, such as @d and 
@u, see ”Using Exceed onDemand Macros” on page 147.

For more information on 
defining the DISPLAY and 
other environment 
variables on UNIX/Linux 
hosts, see below.

If you define the DISPLAY environment variable correctly at a command 
prompt on a particular X application host, you can omit the -display 
displayspec parameter for X applications you start from that shell with the 
following command line syntax: 

[install path]/application [parameters] &

For example:

/usr/bin/X11/xterm -sb -ls -fg blue -bg lightgrey &

Setting Environment Variables on UNIX/Linux Hosts

To simplify the startup of X applications on UNIX/Linux hosts, define the 
following environment variables on your host:

• DISPLAY

• PATH

If you would like to start X applications on a Sun host running 
OpenWindows, you may also need to specify the following environment 
variables on your host:

• OPENWINHOME

• LD_LIBRARY_PATH
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DISPLAY Environment Variable
This section describes how you define the DISPLAY environment variable 
for your current login session on a UNIX/Linux host. Many X applications 
use this variable to determine the X server display they should display.

The table below lists the commands you need to type at the command 
prompt for each shell to set the DISPLAY environment variable. 

PATH, OPENWINHOME, and LD_LIBRARY_PATH 
Environment Variables
This section describes how you specify the PATH, OPENWINHOME, and 
LD_LIBRARY_PATH environment variables on UNIX/Linux hosts. 

Note: The syntax you use to specify the DISPLAY environment 
variable depends on whether you are using the C shell (displays 
a percentage "%" prompt, by default) or the Bourne or Korn shell 
(displays a dollar sign "$" prompt, by default). 

Shell Command Example

C (%) setenv DISPLAY 
displayspec <CR>

setenv DISPLAY eodhost:2 
<CR>

Bourne/Korn ($) DISPLAY=displayspec

export DISPLAY 

DISPLAY=eodhost:2

export DISPLAY

Note: Do not specify the DISPLAY environment variable in your 
host login Xstart file since your displayspec is not necessarily the 
same in each session.

Note: The OPENWINHOME and LD_LIBRARY_PATH environment 
variables are needed only for Sun OpenWindows hosts.
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Using these environment variables, you can add directories to your path 
specification. If you enter a command without specifying its full path, the 
shell searches each directory listed in the PATH, OPENWINHOME, or 
LD_LIBRARY_PATH environment variables for the application executable 
and executes the first one it finds. Consider specifying these environment 
variables in your host login Xstart file, so they are set each time you log into 
the host.

The table below lists the commands required by each shell to set the PATH 
environment variable, where path is a directory that you want to include on 
your host path. Separate multiple paths with colons (:). 

The table below lists the commands required by each shell to set the 
OPENWINHOME and LD_LIBRARY_PATH environment variable, where 
usr is the directory on the host where the X Window system files reside.

Shell Command Example

C (%) setenv PATH path:path:path setenv PATH

/usr/bin/X11:/usr/bin/
jsmith <CR>

Bourne/Korn ($) PATH=path:path:path

export PATH

PATH=/usr/bin/X11:/usr
/bin/jsmith <CR>

export PATH

Shell Example

C(%) setenv OPENWINHOME /usr/openwin

setenv LD_LIBRARY_PATH /usr/openwin/lib

Bourne/Korn($) OPENWINHOME=/usr/openwin

LD_LIBRARY_PATH=/usr/openwin/lib

export OPENWINHOME LD_LIBRARY_PATH
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To determine which environment variables are defined and their values, 
type the following commands at the shell prompt:

To determine if a specific environment variable is defined and to determine 
its value, type the following command at the shell prompt:

echo $variablename

where variablename is the name of the environment variable.

If the environment variable is not defined or is incorrectly defined, define it 
properly in your host login Xstart file.

To define the environment variable in your host startup login file:

1 Open your host startup login file in a text editor. If you are using the 
C shell, the .cshrc file in your home directory is the login Xstart file. If 
you are using the Bourne or Korn shell, the .profile file in your home 
directory is the login Xstart file.

2 Find the environment variable in the file and enter the correct 
command as specified in the tables that precede this procedure.

3 Save the file and exit the text editor.

Shell Commands

C(%) setenv

printenv

Bourne/Korn($) env

export

printenv

Note:  If the environment variable is not defined, specify the 
environment variable by typing the command at the end of the 
file.
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The next time you start a shell session, your environment variable will be set 
according to your host startup login file. To verify this, start a new 
login/shell session and use the necessary commands described to determine 
the current value of these environment variables.

Command Line Syntax for VMS Hosts
This section describes the command line syntax you use to start 
X applications on VMS hosts. 

If your VMS system supports REXEC, RSH, TELNET, or Secure Shell and is 
running version 5.0 or higher of the PCX$SERVER command processor, 
you can specify a command with the following syntax to start an 
X application with Xstart using the REXEC, RSH, TELNET, or Secure Shell 
startup methods:

@@sys$system:pcx$server 4,@#,0,tcpip,@a application

where application is the command line required to run the application.

For more information on 
Exceed onDemand 
macros, see ”Using 
Exceed onDemand 
Macros” on page 147.

You must use the @# and @a macros since the display number and IP address 
are not necessarily the same for each session. For example, to start the xterm 
X application:

@@sys$system:pcx$server 4,@#,0,tcpip,@a DECW$TERMINAL

If you selected the Passive startup mode in Xconfig, and you want to specify 
the X display server to which the X applications should display, you need to 
define the DISPLAY environment variable prior to starting any 
X applications. You do not need to define the DISPLAY environment 
variable when using REXEC, RSH, TELNET, or Secure Shell startup 
methods as PCX$SERVER sets DISPLAY for you.

Note:  Do not specify the DISPLAY environment variable in your 
host login Xstart file since the IP address and display number are 
not necessarily the same in each session.
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Use the following command line syntax to set the DISPLAY environment 
variable.

For example:

set display/create/node=123.183.33.17/transport=tcpip/server=2

When setting the DISPLAY environment variable, keep the following in 
mind:

• You can determine the IP address and display number from the 
information displayed on the Exceed onDemand title bar. 

• Do not put spaces before or after the equal (=) sign.

Once the DISPLAY environment variable is set correctly for a login session, 
you can start X applications from that session using the following command 
line syntax:

run sys$system:decw$application

For example:

run sys$system:decw$clock
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General Accessibility

Hummingbird products are accessible to all users. Wherever possible, our 
software was developed using Microsoft Windows interface standards and 
contains a comprehensive set of accessibility features.

Keyboard Shortcuts     Keyboard shortcuts appear as underlined letters in 
the names of most UI items. If this is not the case, press Alt to reveal them. 
You can use these shortcuts instead of a mouse to navigate the user interface 
and access commands. For example, to open any menu, press Alt and then 
press the key that corresponds with the underlined letter in the menu name. 
In most cases, Alt+F opens the File menu.

Once you have opened a menu, you can access a menu command in the 
following ways:

• Press the underlined letter in the menu command name.

• Use the arrow keys to select the required command, and press enter.

• If one is provided, type the key sequence to the right of the command. 
You can use this key sequence at any time.

Directional Arrows     Use the directional arrows on the keyboard to 
navigate through menu items or to scroll vertically and horizontally. You 
can also use the directional arrows to navigate through multiple options. 
For example, if you have a series of radio buttons, you can use the arrow 
keys to navigate the possible selections.

Tab Key Sequence     To navigate through a dialog box, press the Tab key. 
Selected items appear with a dotted border. You can also press Shift+Tab to 
go back to a previous selection within the dialog box. 

Spacebar     Press the Spacebar to toggle check boxes on and off or to select 
buttons in a dialog box.
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Esc     Press the Esc key to close a dialog box without implementing any new 
settings.

Enter     Press the Enter key to select the highlighted item or to close a dialog 
box with the new settings. You can also press the Enter key to close all About 
boxes.

ToolTips     ToolTips appear for all functional icons. This feature lets users 
use Screen Reviewers to make interface information available through 
synthesized speech or through a refreshable Braille display.

Microsoft Accessibility Options
Microsoft Windows environments contain accessibility options that let you 
change how you interact with the software. This feature can add sound, 
increase the magnification, and create sticky keys.

To configure the Accessibility options:

1 In Control Panel, double-click Accessibility Options. 

2 In the Accessibility Options dialog box, use the tabbed pages to 
configure the option settings.

3 Click OK.
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Technical Support

You can contact the Hummingbird Technical Support department Monday 
to Friday between 8:00 a.m. and 8:00 p.m. Eastern Time.  

Hummingbird Ltd.
1 Sparks Avenue, Toronto, Canada M2H 2W1

Canada and the USA International

Technical Support: 1-800-486-0095 +1-416-496-2200

General Enquiry: 1-877-FLY-HUMM +1-416-496-2200

Main: +1-416-496-2200

Fax: +1-416-496-2207

E-mail: support@hummingbird.com

FTP: ftp.hummingbird.com

Online Request Form: www.hummingbird.com/support/nc/request.html

Web Site: www.hummingbird.com/about/contact.html
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